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Foreword to the First Edition

xxv

IT’S A SMALL CELEBRATION for me to write this foreword—almost exactly
two years after the first meeting of a small group of free software profes-
sionals that turned into the Ubuntu project. A celebration because two
years ago none of us would have predicted that our dream would spawn
several million CDs, three or four million enthusiastic users, hundreds of
commitments of support from companies large and small, a minor prime
time television reference, and now The Official Ubuntu Book.

The dream that brought us together can be simply expressed:

To build a world-class operating system for ordinary desktop computer
users, that is genuinely free and freely available, that is immediately useful,
and that represents the very best that the free software world can achieve
today.

In setting out to build a platform for “ordinary desktop computer users,” I
had no idea that I would have the privilege of meeting and working with
so many extraordinary desktop computer users. Some of those extraordi-
nary individuals are the authors of this book, people who both understand
the importance of the free software movement and have the talent to have
been real contributors to its success. Others make up the backbone of the
Ubuntu community—the small but dedicated army of a few hundred
people that works to produce a new release of Ubuntu every six months.
They are at the heart of a network that reaches out through the global free
software community—through the world of Debian, an extraordinary
project in its own right and without which Ubuntu could not exist, and on
out to the thousands of projects, large and small, that produce the code
and documentation that we pull together and call Ubuntu.



While this huge extended community can often appear to be fractured and
divided along infinitesimal ideological lines, we are all broadly in agreement
about four key ideas, and it is those ideas that are central to the Ubuntu
promise:

� That our software should not come with a license fee. That we should
be able to share our software, modify it, and then share our modifica-
tions, too.

� That this free software should be the best version available, including
regular security updates, and not a tease for a better, commercial
product.

� That full-scale, high-quality commercial support from local and
global companies should be available for this free platform.

� That this software should be usable in as many languages as possible
and usable by as many people as possible regardless of disability.

The 17 of us who met in London two years ago come from a very wide
variety of countries and backgrounds, but we all agreed that the goal of
producing a platform that could live up to that promise was a worthy one,
one that we would devote ourselves to wholeheartedly.

For several months we worked quietly. We wanted to come to the world not
only with a manifesto but also with a clear demonstration of work done
toward our goals, something that people could test and comment on. We
had no name (though industry insiders called us the “Super-Secret Debian
Startup”), and, as a result, we hosted most of our work at www.no-name-
yet.com. We were looking for a name that could express the beauty of the
free software community development process—collaboration, interde-
pendence, sharing, standing gently on the shoulders of giants, and reaching
for lofty goals. The only word that comes close to that, of which I’m aware,
is the African word ubuntu. It is found in many forms in many different
African languages. And so we adopted it as the name of our project. 

We knew that our first release would have blemishes—warts—and gave it
the codename “The Warty Warthog.” We called ourselves “the warthogs”
and coordinated our work on the #warthogs IRC channel. Today, for bet-
ter or worse, that’s turned into a tradition of codenames such as “Breezy
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Badger” and “Dapper Drake.” As lighthearted as they sound, these code-
names come to embody the spirit of our community as it works toward a
particular release. This next one—Dapper—is exactly that: a man emerg-
ing from youth, professional, bold, confident, and energetic. This is our
first release that is designed to meet the needs of large organizations as
much as developers and engineers. In the same way, the Ubuntu commu-
nity has moved from being something of a rebellion against the “Linux
establishment” to a strong and professionally organized group.

What Makes Ubuntu So Popular?
First, this is the time for free software to come to the forefront, and
Ubuntu is very much the beneficiary of the vast amount of work that has
gone into building up a huge body of work in the GNU/Linux world. That
work has been underway for nearly 30 years, in one form or another, but
Ubuntu is one way in which it is suddenly becoming “visible” to the non-
specialist computer user. We are in the middle of a great overturning of the
industry status quo. The last time that happened, in the mid-1990s, was
when the world suddenly found itself connected to itself—by the Internet.
Every major company, especially those in the field of technology, had to
examine itself and ask the question, “How do we adapt to an Internet
world?” Today, every major technology company has to ask itself the ques-
tion, “How do we adapt to a free software world?”

I would speculate and say that Ubuntu represents an idea whose time has
come. We did not invent the free software movement—that honor goes to
Richard Stallman and many others who had a vision far more profound at a
time when it was hard to see how it could ever become reality. But Ubuntu
has perhaps the honor of bringing that vision to a very wide audience in a
form that we can all appreciate. I hope that the real visionaries—those who
have led the way—will appreciate the decisions and the choices we make in
bringing you this project. Some will take exception—I know Linus prefers
KDE to GNOME, for example, so he’s likely to be more of a fan of Kubuntu
than Ubuntu. But in general, the ideas that others have had, the principles
of the free software movement, are well expressed in Ubuntu.

Second, Ubuntu is a project on which you can have a real impact. It has the
benefit of deep and reliable financial backing and a corporate team to give
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it muscle, but it is in every regard an open project, with participation at the
highest levels by true volunteers. We work in a fishbowl—our meetings take
place online, in a public forum. That can be tricky. Building an operating
system is a fast-paced business full of compromise and tough decisions in
the face of little information. There are disagreements and dirty laundry,
and mistakes are made. (I should know; some of them are mine. You should
hear the one about the Warty Warthog desktop artwork.) The transparency
of our environment, however, means that we can count on having robust
conversations about our options—all of them, even the ones the core team
would never have dreamed up. It also means that mistakes are identified,
discussed, and ultimately addressed faster than they would be if we lived
and worked behind closed doors. You get a better platform as a result.

We work hard as a community to recognize the contributions of all sorts
of individuals—advocates, artists, Web forum moderators, channel opera-
tors, community event organizers, writers, translators, people who file and
triage bugs . . . whatever your particular interest or talent, we will find a
way to integrate your contribution.

Perhaps most important is the way our approach to community differenti-
ates Ubuntu from other free software projects with similar vision. We try to
do all of this in a way that recognizes that disagreements are important but
prevents those disagreements from creating deep divides in our commu-
nity. Our code of conduct may not be perfect, but it reminds each of us to
remember the meaning of the word ubuntu—that each of us has our best
impact through the relationships we maintain with one another. Finding
common ground and maintaining healthy communication are more
important for us as a community in the long run than a particular technical
decision or the specific choice of words with which to translate “File” into
Spanish. Our community governance structures—our Technical Board
and Community Council—exist to ensure that debates don’t become per-
sonal and that decisions can be taken after all sides have been heard.

If you are a software professional or curious about Linux, this book and this
platform are an excellent choice. You will learn about the world of Ubuntu
and, indirectly, Debian and GNU/Linux. These are great foundations for
working with the tools that I believe will come to define the “standard,” the
everyday computing base upon which we build our homes and offices.
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I once heard a proprietary software vendor say, “Linux is more expensive
because skilled Linux professionals are more costly.” This is true. It means,
of course, that Linux skills are more valuable! It won’t be true forever
because the world of Linux is expanding so rapidly that sooner or later we
will have to accept a position in the mainstream, and that takes off some of
the “geek points” associated with being part of the “future of technology.”
But right now, without a doubt, being ahead of the curve on Linux and on
Ubuntu is the right place to be. If you’re this far into this foreword, you are
clearly going to make it. ;-) 

It’s difficult for me to speculate on what the future might hold for the
Ubuntu project. I know that I along with many others are loving the
opportunity to be at the center of such an exciting initiative and are com-
mitted to seeing where it leads us over the coming years. I believe that it
will become a pervasive part of our everyday computing environment, so I
would like to help make sure that we don’t make too many mistakes along
the way! Please, come and join us in the fishbowl to help ensure we do a
very, very good job.

—Mark Shuttleworth
Ubuntu Founder

April 2006
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AS WE WRITE THIS, it is several years since we penned the first edition of The
Official Ubuntu Book and a year since the third. The last year has seen
Ubuntu continue its explosive growth. Updating this book drives this fact
home in striking ways. For example, the number of users and posts in the
Ubuntu Forums has nearly doubled since the last edition of this book a
year ago. Again. The number of officially supported flavors of Ubuntu have
been added to. Again. Once again, we feel blessed that The Official Ubuntu
Book has been able to benefit from, and perhaps in a small way even con-
tribute to, that success. Ultimately, that success paved the way for the sec-
ond, third, and now the fourth edition of the book that you’re reading now.

In the process, this book, like Ubuntu, is beginning to mature. Like
Ubuntu, we have now put together our piece a few times and are beginning
to get more comfortable. Our job as authors, like that of the Ubuntu devel-
opers, now involves more updating and polishing than it used to. Distrib-
uted under a free license, a once-risky book on a once-risky operating
system is, just a few short years later, as close to a sure thing as an author,
publisher, and if we have done our job well, a reader, could hope for.

And yet with success comes responsibility to our readers and to our users
with high expectations. Ubuntu’s success is built in part of maturity and
excellence, and it cannot sacrifice these qualities if it will succeed. We can-
not either. Our job as writers is complicated because we need to accurately
reflect and represent both while catering to an increasing and increasingly
diverse group of users.

As we’ve noted in the prefaces to previous editions of this book, being
Official has carried with it a set of rights and responsibilities. Our book’s
title means that we must attempt to reflect and represent the whole
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Ubuntu community. While we, as authors, are expected to put ourselves
into the book, it is understood that it can never be to the detriment of the
values, principles, technologies, or structures of the Ubuntu community.

Doing this has been complicated as Ubuntu has grown. In each edition, we
have added a new chapter, because the Ubuntu community has grown to
include new projects. In each revision of this book, we have needed to add
to the list of related projects, tools, and community initiatives. As the
Ubuntu community grows, it is impossible to give a complete accounting
of what Ubuntu has to offer. Creating a summary requires some hard deci-
sions. At the end of the day, we are constrained by page count and our own
limited schedules.

Meanwhile, as with earlier editions, we needed to write this book about a
new release of Ubuntu while that version was under active development
and was being redesigned, rethought, and rebuilt. Every day, Ubuntu grows
in different, unpredictable ways, and this growth has increased exponen-
tially with the size of the community and the diversity of the userbase. Our
book’s development process had to both match and track this process as
our content was crafted, rewritten, adjusted, and allowed to mature itself.

As in the previous edition, the contributors to this book go well beyond
those listed on the book’s cover. As in the first three editions, the recipes
included in Chapter 6 have been elicited from and designed in consulta-
tion with the community. But while the community contributions are
sometimes less visible in other chapters, they are no less present. Invisible
to most readers, dozens of members of the community left their mark on
different parts of the text of this book. Although this degree of participa-
tion led to a writing process that was as hectic, and at times frustrating, as
the process that builds Ubuntu, we hope we can remind readers of the
level of quality that this process inspires in our book’s subject. In the places
where we achieve this, we have earned our book’s title. With that goal in
mind, we look forward to future versions of Ubuntu and editions of this
book wrought through the same community-driven process.
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WELCOME to The Official Ubuntu Book, Fourth Edition!

In recent years, the Ubuntu operating system has taken the open source
and IT world by storm. From out of nowhere, the Little Operating System
That Could has blossomed into a full-featured desktop and server offering
that has won over the hearts of users everywhere. Aside from the strong
technical platform and impressive commitment to quality, Ubuntu also
enjoys success because of its sprawling community of enthusiastic users
who have helped to support, document, and test every millimeter of the
Ubuntu landscape.

In your hands you are holding the official, authorized guide to this impres-
sive operating system. Each of the authors selected to work on this book
has demonstrated a high level of technical competence, an unbridled com-
mitment to Ubuntu, and the ability to share this knowledge in a simple
and clear manner. These authors gathered together to create a book that
offers a solid grounding to Ubuntu and explains how the many facets and
features of Ubuntu work.

About This Book
At the start of every book, on every bookshelf, in every shop, is a para-
graph that sums up the intentions and aims for the book. We have one
very simple, down-to-earth aim: to make the Ubuntu experience even
more pleasant for users. The Ubuntu developers and community have
gone to great lengths to produce an easy-to-use, functional, and flexible
operating system for doing, browsing, and creating all kinds of interesting
things. This book augments that effort. With such an integrated and flex-
ible operating system, this guide acts as a tour de force for the many things
you can do with Ubuntu.



The Scope of the Book
With so much to cover, we had our work cut out to write a book that could
cover the system in sufficient detail. However, if we were to write in depth
about every possible feature in Ubuntu, you would need to buy a new
bookcase to store the sheer amount of content.

Part of the challenge in creating The Official Ubuntu Book was selecting the
topics and content that can be covered within a reasonably sized book. We
have identified the most essential content and written only about it. These
chosen topics not only include installation, use of the desktop, applications,
multimedia, system administration, and software management, but also
include a discussion of the community, online resources, and the philoso-
phy behind Ubuntu and open source software. As a bonus, we decided to
squeeze in a chapter full of useful troubleshooting recipes that you can use
when you need to troubleshoot problems, and we expanded our discussion
of projects related to Ubuntu that will be of interest to you. We believe this
book provides an ideal one-stop shop for getting started with Ubuntu.

The Menu
Here is a short introduction to each chapter and what it covers.

� Chapter 1—Introducing Ubuntu: This spirited introduction
describes the Ubuntu project, its distribution, its development
processes, and some of the history that made it all possible.

� Chapter 2—Installing Ubuntu: We walk through the installation
process one step at a time to clearly describe how anyone interested
may begin using Ubuntu on their own computer.

� Chapter 3—Using Ubuntu on the Desktop: This is an informative and
enjoyable introductory tour of the Ubuntu desktop, the applications
included, and ways to configure and customize your desktop.

� Chapter 4—Advanced Usage and Managing Ubuntu: We explore
some of the advanced ways to use Ubuntu, including managing the
system. These features are not vital if you want to use the computer
only as a simple tool, but once you learn how to install and manage
software, use hardware devices and printers, interact with remote
computers, use the terminal, and run some Windows programs under
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Ubuntu, you will find your overall experience even more rewarding
and enjoyable. 

� Chapter 5—The Ubuntu Server: This introduction to Ubuntu Server
installation and administration includes coverage of command-line
package management, basic security topics, and advanced installer
features like logical volume management and RAID.

� Chapter 6—Support and Typical Problems: Packed to the seams with
lots of small, independent recipes, this chapter teaches you how to
solve problems or meet unique requirements in your setup.

� Chapter 7—The Ubuntu Community: The Ubuntu community is
larger and more active than many people realize. We discuss many of
its facets, including what people like you do to build, promote,
distribute, support, document, translate, and advocate Ubuntu—and
we tell you how you can join in the fun.

� Chapter 8—Using Kubuntu: The most popular spin-off project from
Ubuntu is Kubuntu. This chapter provides a solid introduction and
primer for getting started.

� Chapter 9—Using Edubuntu: We offer in-depth coverage of the
Edubuntu project and community, an Ubuntu derivative designed for
educators and the schools in which they work.

� Chapter 10—Ubuntu-Related Projects: There are a number of Linux
distributions based on Ubuntu that you will find interesting and
possibly useful. We discuss some of these as well as projects that are
integral to the creation of Ubuntu, such as Launchpad and Bazaar.

� Chapter 11—Introducing the Ubuntu Forums: For hundreds of
thousands of people, the Ubuntu Forums have provided the first
glimpse of and interaction with the greater Ubuntu community.
Especially for new users, this has become the most important venue
for support. We explore the forums and the people, history, and
processes that have built them.

� Appendix A—Welcome to the Command Line: You can begin to take
advantage of the power and efficiency of the command line with the
clear, easy-to-use examples in our brief introduction.

� Appendix B—Ubuntu Equivalents to Windows Programs.

Introduction xxxix



The Ubuntu team offers several installation options for Ubuntu users,
including CDs for desktop, alternate install, and server install. These three
CD images are conveniently combined onto one DVD included in the
back of this book, allowing you to install Ubuntu for different configura-
tions from just one disk. There is also an option to test the DVD for defects
as well as a memory test option to check your computer.

The first boot option on the DVD, Start or Install Ubuntu, will cover most
users’ needs. For more comprehensive information, check the Help feature
by selecting F1 on the boot menu. You can also refer to Chapter 2, which
covers the Ubuntu installation process in detail.

You can find the DVD image, the individual CD images (for those who
don’t have a DVD drive), and Kubuntu and Edubuntu images on www.
ubuntu.com/download.
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Using Ubuntu on the Desktop



WITH UBUNTU INSTALLED and ready to go, it’s time to get started using your
new desktop. The stock install of Ubuntu provides a very complete and flex-
ible system. Unlike other operating systems, such as Microsoft Windows or
Mac OS X, Ubuntu includes everything you need to get started, such as an
office suite, media tools, a Web browser, a graphics package, an e-mail client,
and more. Once the installation is complete, you are up and running right
away without having to install any additional software. Different people use
their computers in different ways, and every user has her own personal pref-
erence for look and feel. Recognizing this desire, Linux has the capability to
use any one of a number of different graphical interfaces. This flexibility,
combined with the ballooning popularity of Linux and open source, has
resulted in literally hundreds of different graphical environments springing
up, each covering these different types of users and ways of working.

Even though there is a huge range of different environments available,
there are two clear leaders in KDE and GNOME. Each environment pro-
vides a good-looking, comprehensive, and easy-to-use desktop, but they
differ in how that desktop is used as well as in how further personaliza-
tion can take place. The KDE system is in many ways more akin to Win-
dows but aims for complete configurability of the desktop. If an option
exists, the user has easy access to it and can change the behavior and look
of almost everything. The competing GNOME desktop takes inspiration
from both Windows and Mac OS X and sets a priority on simplicity and
ease of use. GNOME is still easy to customize, but the less common
options are either eliminated or well hidden to prevent user overload.
Luckily, Ubuntu users are blessed with the choice of either desktop—the
default desktop in stock Ubuntu is GNOME, and the Kubuntu distribu-
tion uses the KDE desktop. Kubuntu is covered in Chapter 8.

In this chapter, you get started with GNOME and use it to do the normal
things you face every day with your computer and a few not-so-normal
things. This includes opening and running applications, managing your
files, adjusting the look and feel, using applications, managing your
media, and more. Buckle up and get ready to take your shiny new desktop
for a drive!

TIP The Ubuntu Desktop Is GNOME
When reading about Ubuntu, you often see the terms Ubuntu desktop and GNOME used
interchangeably. Both of these terms refer to the same thing—the default Ubuntu desktop is
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a version of GNOME itself. Of course, Ubuntu provides several other desktops, including
KDE (in Kubuntu), Xfce (in Xubuntu), and a variety of others.

Taking Your Desktop for a Ride
When you start your Ubuntu system, you are asked for a username and
password to log in with. In the last chapter you specified a user account
when installing the system, so use that to log in. First type in your user-
name and press Enter, then your password and press Enter.

TIP Language? Sprache? Langue? Lingua?
Click the Options > Select Language button to change the language of the desktop. If you
click the button and the selection does not include your language, jump to the Ubuntu in
Your Language section on page 103 to learn how to add new language packs. 

After a few seconds you will see the Ubuntu desktop appear (Figure 3-1).
The desktop has three main areas.

1. At the top of the screen is the panel. This bar contains the desktop
menu options and application shortcut icons on the left side as well 
as the notification area on the right side. You use this bar to load
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applications and to see the status of certain activities on your system.
The panel is always visible when you use your desktop.

2. The large middle part of the screen is the desktop. This part of the
screen is normally covered by the applications that you use, but you
can also put icons and shortcuts on the desktop, too.

3. The bottom part of the screen is called the taskbar. This area displays
a rectangle for each open application, just like in Windows.

You may have noticed that, unlike other operating systems, there are no
icons on the desktop. The reason for this is that desktop icons typically get
covered by applications, and, as such, you can’t get at them. If you need to
start applications, you typically use the Applications menu or the shortcuts.

TIP Device Icons
Although there are no application icons on the desktop, when you plug in USB devices such
as portable music players, keyring drives, or digital cameras, a device icon will appear on the
desktop.

Starting Applications and Finding Things
Starting applications is simple. Just click on the Applications menu on the left
side of the panel. Inside this menu are a number of submenus for different
types of applications. Hover your mouse over each category, and then click
the application you want to load. As an example, click on Applications >
Internet > Firefox Web Browser. After a few seconds the browser will pop up.

When applications are loaded, the brown window border has three but-
tons on the right-hand side:

� Left button (thin white line): This is used to minimize the applica-
tion and put it in the taskbar.

� Middle button (white square): This maximizes the window to take
up the full desktop area.

� Right button (white cross): This button closes the application.

Every application has an entry in the taskbar at the bottom of the screen.
You can click these entries to minimize or maximize the application and
right-click to see some other options.
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Changing Your Menu Layout  Although the main Applications, Places,
and System menus are logical by default, you may want to further cus-
tomize them by moving entries into different submenus, not displaying
certain items, and making other tweaks. All of this is easily done with the
built-in menu editor.

To edit the menus, open the option at System > Preferences > Main Menu.
The menu editor will appear, as shown in Figure 3-2.

The menu editor is fairly intuitive. To adjust which items are shown, click
on a submenu in the left-hand pane and change the Show checkbox for the
items you want to show or hide. To add a new item, select the submenu the
item should appear in, and then click the New Item button on the right-
hand side. The box shown in Figure 3-3 will appear.

Menu items can be applications (the default), applications running in ter-
minals, or files. Select the appropriate setting for the Type box for your
menu item, or leave it as Application. Provide a name for your menu item in
the Name box, the command to run in the Command box (or the location
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of your file in the Location box if you changed the type to File), and a brief
description in the Comment box. You can also use the Browse button to
select the application to run (or the file to open). Finally, click the default
icon off to the side, and select an icon for the item. Click OK to finish adding
the new menu item.

Finding Your Files and Folders
When using your computer, you often need to save and open files and
folders, move them around, and perform other tasks. The Places menu
contains a bunch of entries, including those listed here, to access different
parts of your computer and the network. 

� Home Folder: Your home folder is used to store the files and work for
each user who is logged in. This is the most important folder on the
system, and you can think of it as the equivalent of My Documents in
Windows—virtually everything you save lives here. Each user has a
separate home folder.

� Desktop: The Desktop folder is inside your home folder and contains
files that visually appear on your desktop as icons. If you drag a file
onto your desktop, it will appear in the Desktop folder. Similarly,
moving a file out of this folder or deleting it will remove it from your
desktop.

� Computer: Clicking this item displays the different drives attached to
your computer as floppy drives, CD/DVD drives, and USB keys or
sticks. This is the equivalent of the My Computer icon in Windows.
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� Network: This option accesses servers that are available on your local
network. This is the equivalent of the Network Neighborhood in
Windows.

� Connect to Server: Click this to run a wizard to create a connection
to a network server. You can use this to add an icon to the desktop
that, when clicked, provides a list of remote files in the desktop file
manager. You can then treat this window like any other file manager
window and drag files back and forth. This is really useful for copying
files to other computers.

� Search for Files: Use this to search for files on your computer.

� Recent Documents: Click this submenu to display the most recently
used documents.

Configuring Your System
The third and final menu, System, is used to configure and customize your
system, access help, and report problems. Inside the menu are a few options,
including these:

� Preferences: This submenu contains items for customizing the look
and feel of your desktop. Each of these settings applies only to the
desktop of a user who is logged in. If you log in as another user, the
settings change to that user’s preferences.

� Administration: This submenu is used to configure systemwide
settings such as networking, users, printing, and more. To use these
menu items, you need to know the system administrator password.

� Help and Support: With this you can access the Ubuntu Help Center,
which provides documentation and guides for your Ubuntu desktop.

TIP Feel the Power
When you installed Ubuntu, you were asked for a username and password for the system.
This password not only provides access to your normal user account but also accesses the
all-powerful Administration features. As such, when you access the menu options and are
asked for the password, just enter your normal password, and you can use those features.

This feature applies only to the first user account that you created on the system. If you add
other accounts, those users cannot access the Administration options unless you explicitly
give them access.
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Shortcut Icons
On the panel are a number of shortcut icons next to the menus. These
small icons are always visible and can be single-clicked to gain immediate
access to your favorite applications. Ubuntu comes with several stock
shortcuts on the panel, but you are welcome to add your own.

Adding your own icon is as simple as finding the application you want to
add in the menu and then dragging it to the panel. You can then right-click
the new shortcut icon and select Move to move it to the right place.

Applets
One simple yet powerful feature in Ubuntu is the ability to run small pro-
grams called applets on the panel. These small programs are useful for a
variety of tasks and provide quick and easy access via the panel.

To add an applet, right-click the panel and select Add to Panel. The win-
dow shown in Figure 3-4 pops up. Select one of the many applets, and click
Add. When the applet appears on the panel, you can press the middle
mouse button (or the left and right buttons together) to move it around.
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The Notification Area
In the right-hand part of the top panel is the notification area and the
clock. The notification area is similar to the Windows system tray in that it
provides a series of small icons that indicate something specific. A good
example of this is Network Manager, which looks after your network con-
nections—both wired and wireless—for you.

You can fiddle with the notification area items by right-clicking them to
view a context menu. Some icons (such as the volume control) allow you
to left-click on them to view them. As an example, try clicking the little
speaker icon and adjusting the slider.

QUICK TIP Right-click the volume icon and select Open Volume Control to access the mixer settings for
your sound card. These settings configure the speakers, microphone, line-in, and any other
sound card inputs or outputs.

The Clock
Next to the notification area is the clock. Click on the clock to view a cal-
endar. Later, when you use Evolution, items that are added to your calen-
dar appear in the clock applet too. Instead of opening up Evolution to
find out when your dentist appointment is, just click on the clock to see it
immediately.

QUICK TIP Customize your clock by right-clicking it and selecting Preferences.

The Taskbar
The taskbar sits at the bottom of the screen. This small bar is always visible
and indicates which applications are currently open. In addition to this,
the taskbar also sneaks in a few other handy little features.

To the far left of the taskbar is the Hide/Show Desktop button. Clicking
this button hides all of your open applications and shows the desktop.
Clicking it again redisplays them. This button is useful when you need to
quickly access something on your desktop.
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Next to this button is the applications area, which shows each of the cur-
rently open applications. For each application, an entry is added, and you
can right-click it to view a context menu. This menu can also be used to
minimize, maximize, resize, close, and otherwise control applications.

QUICK TIP You can switch between multiple applications in Ubuntu just like in Windows by pressing
Alt-Tab. When you press this key combination, a small window appears that can be used to
switch between active applications.

To the right of the applications area are two small rectangles called the work-
spaces. Each of these rectangles represents another screen in which you can
view an application. As an example, you may be using your Web browser
and e-mail client while talking to your friends in a chat client on the first
desktop and working on a document on the second desktop. You can then
just click each virtual desktop to switch to it to access your different applica-
tions. Another useful tip applies when you’re moving applications between
virtual desktops—if you have an application on the first desktop, just right-
click the brown window or the taskbar entry, select Move to Another Work-
space, and pick the relevant workspace number. The menu also has Move to
Workspace Left and Move to Workspace Right options. This makes moving
applications between your workspaces quite simple.

QUICK TIP Although Ubuntu has only two workspaces configured by default, you can have as many—
or few—as you like. To configure them, right-click on one of the workspaces in the bottom
right-hand corner of your screen, and select Preferences from the menu.

To the right of the workspaces is the trash. Files that are dragged onto this
icon are destined to be deleted. To fully delete these files, right-click the
trash and select Empty Trash.

TIP Usability and the Ubuntu Desktop
Throughout the development of the Ubuntu desktop, great care and attention have gone into
usability. As an example, the four corners of the screen are established as areas that are
simple to access—you don’t need to carefully mouse over the area and can instead just
throw your mouse to the corner. This is why each corner has an important feature. It makes
accessing each feature that little bit easier.

Ubuntu is filled with tiny usability improvements such as this that help make it as intuitive
and powerful as possible.
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Shutting Down Your Computer and Logging Out
Now that you’re becoming acquainted with Ubuntu, you’ll want to keep
using it as long as possible, but there will always come a time when you have
no choice but to leave your computer and go do something else. As you
have already seen, Ubuntu is extremely flexible, and this area is no excep-
tion. Click the icon in the top right of the screen by your username to see
the various options (shown in Figure 3-5) for ending your current comput-
ing session.

There are a number of options available upon logout, however, the choices
presented to you will depend on your installation (e.g., Suspend may not
be available).

� Guest Session: This option lets you allow someone else to use your
computer while keeping you logged in but your data and account
secure by giving the guest a limited desktop to work with temporarily
and requiring your password to return to your desktop. 

� Lock Screen: This option locks the screen. This is useful when you
need to use the bathroom or grab some lunch. It will lock the
computer and ask for your password to reenable the desktop.

� Log Out: This option lets you log out of the current session and go
back to the main login screen. 

� Suspend: If your computer supports Suspend, this option will be
included in the list, and you can click it to save the current state of
your system in RAM. The next time your computer is turned on, the
desktop will be resumed. This option continues to use battery power
but only a minimal amount.
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� Hibernate: When you click this option, the current state of the system
is saved to the hard disk and can be switched off. This is like the
Suspend option but slower.

� Restart: Click this to restart the computer.

� Shut Down: Click this to shut down your computer.

Using Your Applications
Now that you have become familiar with the desktop, let’s explore some of
the many applications included on your new system. By default, Ubuntu
comes with a wide range of popular and established applications to listen
to music, watch videos, create documents, browse the Web, manage your
appointments, read your e-mail, create images, and much more. These
applications have been vetted by the developers to ensure they are the best-
of-breed Linux applications available.

Although Ubuntu includes a range of software applications, it is likely you
will want to install extra applications and explore other available software.
Fortunately, the Ubuntu system is built on a powerful foundation that
makes software installation as simple as pointing and clicking. Click
Applications > Add/Remove, and a dialog box appears that you can use to
install new applications. Just browse through the different categories and
check the applications to install. Click the Apply button, and the applica-
tion is downloaded and installed for you.

This tool provides a simple way to access a limited core set of popular appli-
cations, but there are actually more than 20,000 packages available to your
Ubuntu system. Software installation is discussed in detail in Chapter 4.

TIP Another Way to Run Applications
Although you will most typically start your applications by selecting them from the Applica-
tions menu, you can also press Alt-F2 to bring up a box where you can type in the name of
an application and run it.

Browsing the Web with Firefox
Firefox is the default Ubuntu Web browser and provides you with a
simple, safe, and powerful browsing experience. Firefox has become one of
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the most successful open source projects in the world and continues to
garner huge popularity. With hundreds of millions of downloads and rap-
idly increasing browser share, Firefox has been an unparalleled success.

Fire up Firefox by clicking its icon (the first one next to the System menu)
on the panel or by selecting Applications > Internet > Firefox Web Browser.
Before long, you’ll be presented with the main Firefox window (Figure 3-6).

The Firefox window looks similar to most Web browsers and includes the
usual back, forward, reload, and stop buttons, an address bar, and some
menus. These familiar-looking elements help you become acquainted
with Firefox, and if you have used Internet Explorer, Opera, Netscape, or
Safari before, you are sure to pick it up in no time.

Navigating your way around the Internet is no different in Firefox than in
any other browser—just type the Web address into the address bar and
press Enter. Firefox also has a few nice features that make it easy to access
your favorite sites. As an example, if you want to visit the Ubuntu Web site,
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you can just enter www.ubuntu.com (leaving off all that http:// nonsense).
Alternatively, you can just type in “Ubuntu,” and Firefox will do the equiv-
alent of going off to Google, entering “Ubuntu” as the search term, and
taking you to the first result for the search. This feature is incredibly handy
for popular sites that are likely to be at the top of the search results page.

TIP The search box next to the address bar can be used to do searches. By default, these
searches are on Google. To do a Google search, just type in your search term and press
Enter. You can also click the down arrow next to the “G” and select from a variety of other
sites to search, including the Ubuntu software archive Web site and Wikipedia 

This search box can be used to search just about anything. To add more search engines,
click the small icon and then select Manage Search Engines.

Tabbed Browsing  If you are anything like any of the authors behind this
book, you look at a number of different Web sites each time you use the
Internet. It is not uncommon to have your Webmail open as well as
Wikipedia, some discussion forums like the Ubuntu Forums, news sites,
blogs, and more. Before long, your desktop is littered with browser win-
dows, and your taskbar is full to the brim.

Firefox has a nimble solution to this problem in the form of tabbed brows-
ing. If you are looking at your friend’s Web site about raccoons and decide
you want to check out your favorite sports player’s Web site, just click
File > New Tab or press Ctrl-T and—ta-da!—a new tab is unveiled in your
browser window. You can now load another page inside this tab.

The tabbed browsing fun doesn’t stop, though—oh no! When you are read-
ing the Web and you see a link you are interested in viewing, right-click the
link and select Open Link in New Tab. The page will load in the new tab,
and you can continue reading the article and view the link afterward.

Bookmarking Your Favorite Sites  To bookmark the page you are viewing,
click Bookmarks > Bookmark This Page. In the dialog box that pops up,
use the combo box to select the folder to store the bookmark in. You also
have the option to add “tags” to your bookmark, which are like keywords
that can be used to sort and search for your bookmarks in the future.
When you have finished naming and tagging your bookmark, click Done
to save the bookmark.
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Save Time with Live Bookmarks  Firefox also includes a special feature
called live bookmarks that automatically grabs content from a Web site with-
out your needing to visit it. As an example, go to http://fridge.ubuntu.com
(a popular Ubuntu news site), and you will see a small orange icon—which
indicates that this site has feed available—on the right side of the address bar.
Click this orange square, and you will be taken to a new page that previews
the feed and gives you the option of what you would like to use to subscribe
to it. Use the default option (Live Bookmarks), and click Subscribe Now. A
dialog box will pop up. Use the default values provided and click OK. A new
toolbar button is added, and when you click on it, a list of the items from the
Web site are displayed. Each time you start Firefox, it will quietly go away and
update this list so that you don’t need to visit the site yourself.

TIP If You Liked the Fridge
You may also like Planet Ubuntu at http://planet.ubuntu.com. This site collects the personal
blogs of a number of different Ubuntu developers and other community members. Planet
Ubuntu gives a unique insight into what the developers are working on and/or interested in.

Bolt It On, Make It Cool  Although Firefox is already a powerful and flex-
ible Web browser, it can be extended even further using special plug-in
extensions. These extensions cover not only typical browsing needs but
also other more specialized extras that extend the browser itself.

To install normal Web plug-ins, just visit a site that requires the plug-in. A
yellow bar will appear at the top of the page, indicating that you are miss-
ing a plug-in necessary to fully take advantage of the page you are visiting.
Click the Install Missing Plug-ins button to grab the required plug-in. For
example, Ubuntu does not come with the Macromedia Flash plug-in
because it does not live up to Ubuntu software freedom requirements. As a
result, you will have the option to install either Macromedia Flash or the
free software version Gnash if you want to use Flash.

To extend the browser itself with additional features, go to https://addons.
mozilla.org and browse for an extension that you are interested in. When
you find something you would like to install, click the Install link. A dialog
box will pop up asking you to confirm the installation. Click Install Now.
Your new extension will now download and install automatically. Typi-
cally, this requires a restart of Firefox, and then your extension is available.
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TIP Be Careful Where You Download
It is recommended that you download extensions only from http://addons.mozilla.org. If you
do need to install an extension from another site, make sure it is a site you trust. Otherwise,
the extension may contain unsafe software, viruses, or spyware.

Creating Documents with OpenOffice.org
Included with Ubuntu is a full office suite called OpenOffice.org. This
comprehensive collection contains applications for creating word process-
ing documents, spreadsheets, presentations, databases, drawings, and math-
ematical equations. The suite provides an extensive range of functionality,
including reading and writing Microsoft Office file formats, and can also
export documents as Web pages, PDF files, and even animations.

Let’s give OpenOffice.org a whirl by creating a letter with it. Start Open -
Office.org word processor by selecting it from the Applications > Office
menu. When it has loaded, you will be presented with the interface shown
in Figure 3-7.
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If you have used a word processing program before, many of the common
interface elements, such as the buttons for setting font type and size, bold,
italic, underline, and alignment, look and behave the same. The OpenOf-
fice.org developers have designed the suite to be easy to migrate to if you
have used a program like Microsoft Office before. After a few minutes
playing with OpenOffice.org, you will be confident that you can find the
functions you need.

Start your letter by first choosing a nice font. In the font combo box, you
should see Times selected as the default. Click the box and instead choose
the lovely Bitstream Vera Sans font. Change the font size by clicking the
combo box to the right of the font box and selecting 10 as the size. With
the cursor on the left side of the page, add your home address to the letter.

Now press Enter to leave a blank line under the address, and click the Align
Right toolbar button (the icon looks like some lines aligned to the right). If
you are unsure of what a button does, hover your mouse over it to pop up
a tool tip. Now add to your letter the address of the recipient.

Press Enter again to leave a blank line, and type the main body of the letter.
Feel free to use the bold, italic, and underline buttons to add emphasis to
your words. You can also use other toolbar buttons to add items such as
bullet points and numbered lists and to change the color of the font. If you
want to add features such as graphics, tables, special characters, and frames,
click the Insert menu and select the relevant item. You can customize each
item added to the page by right-clicking the item and using the options
shown in the context menu.

When your letter is complete, you can save it by selecting File > Save,
by clicking the floppy disk toolbar icon, or by pressing Ctrl-S. The
default file format used by OpenOffice.org is the OpenDocument For-
mat. This file format is an official open standard and is used across the
world. The file format is slightly different for different types of applica-
tions (.odt for word processor files, .ods for spreadsheets, and so on),
but each format provides an open standard free from vendor lock-in.
You can also save in a variety of other formats, including the default for-
mats for Microsoft Office.
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TIP Vendor Lock-In?
In the proprietary software world, it is common for each application to have its own closed
file format that only the vendor knows how to implement. When a person uses the software
to create documents, the closed format means that only that specific tool can read and write
the format. As long as you want to access your documents, you need that tool. This is
known as vendor lock-in.

To combat this problem, the OpenOffice.org suite (and the vast majority of other open
source applications) uses an open file format that is publicly documented. In fact, the format
is a published standard under ISO/IEC 26300:3006. This means that other applications can
implement the OpenDocument file format, and you can be safe in the knowledge that your
documents will always be available and you are not locked in to any specific tool.

Another useful feature wedged into OpenOffice.org is the capability to
save your documents in the Adobe PDF format. PDF files have been
increasingly used in the last few years and are useful for sending people
documents that they should not change (such as invoices). PDF files pro-
vide a high-quality copy of the document and are well supported across all
operating systems. This makes PDFs ideal for creating catalogs, leaflets,
and flyers. To save a document as a PDF file, click the PDF button on the
main toolbar (next to the printer icon). Click the button, enter a filename,
and you are done. Simple.

Managing Your E-mail and Calendars with Evolution
Evolution has been modeled around the all-in-one personal information
management tool. Within Evolution you can read your e-mail, manage
your schedule, store contact details, organize to-do lists, and more in a
single place. This makes Evolution useful for both businesspeople and reg-
ular users who want easy access to this information.

Setting Up Your E-Mail Account  To use Evolution to read your e-mail, you
need to find out the following settings for connecting to your e-mail server
(you can get these details from your ISP or system administrator):

� Your type of e-mail server (such as POP or IMAP)

� Your mail server name (such as mail.chin.com)

� Your mail account’s username and password

� Authentication type (typically by password)
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� Your outgoing mail server type (typically SMTP)

� Your outgoing mail server name

TIP Evolution and Webmail
You can’t use Evolution to read Webmail such as Yahoo! Mail, or Hotmail unless you con-
figure your Webmail to output as POP and use SMTP to send e-mail. Consult your Web-
mail provider for more details on if and how you can access the mail with a local client like
Evolution.

Load Evolution by clicking the envelope and clock shortcut icon from the
panel (hover your mouse over the shortcuts to see what they are) or by
clicking Applications > Internet > Evolution Mail. When the application
loads, you are taken through a wizard to set up your e-mail server (as
shown in Figure 3-8).
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mail server.



Click Forward to continue the setup, and after choosing to not restore
from a backup, you will be asked for your identity. Fill in your e-mail
address in the E-Mail Address box, and add the optional information if
you want to. The additional details are not essential for using Evolution.
Click Forward to continue.

You are next asked to choose what kind of e-mail server you have from the
drop-down box. When you make your selection, some additional settings
are displayed. Fill in the server name and the username. You may need to
adjust the Security and Authentication Type settings, but for most
accounts the default settings should be fine. Click Forward to continue.

The next page configures some options for receiving your e-mail. None of
these options are essential, although you may want to check the first box to
automatically check for new mail. Click Forward to continue. The next
screen configures the settings for sending e-mail. In the combo box select
the Server Type (typically SMTP) and add the server name to the Server
box. Click Forward to continue.

In the next screen enter a name to describe the account. The default entry
(your e-mail address) is fine, but you may want to add something more
meaningful such as “Work E-Mail” or “Home E-Mail.” When you have
added this, click Forward to continue. Finally, select your location from the
map. If you click on your area of the world, the map will zoom in. Once you
have done this, click Apply to complete the process and close the wizard.

With the wizard completed, the main Evolution interface will appear, as
shown in Figure 3-9.

On the left sidebar you can see a number of buttons to access the mail,
contacts, calendars, memos, and tasks components in Evolution. When
you click each button, the interface adjusts to show you the relevant infor-
mation about that component.

Working with Your E-Mail  Inside the e-mail component you can see the
e-mail folders in the left panel and the list of messages in the top pane.
When you click on a message, it is displayed in the bottom pane, where
you can read it. With your new account set up, you will first want to go and
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grab the e-mail from your mail server. Click Send/Receive, and the mail is
retrieved from your server and any unsent mail is sent.

TIP Problems?
If you cannot connect to your mail server, there may be an error in your account configura-
tion. To edit your account settings again, click Edit > Preferences, select the account from
the list, and click Edit.

With your messages loaded, new e-mails are shown in bold in the top pane.
Move through the different e-mails using the up and down arrow keys, and
each message will be displayed. You can reply to a message by clicking the
Reply or Reply To All toolbar buttons. New e-mails can be created by click-
ing the New toolbar button. By default, new e-mails and replies are sent
automatically when you click the Send button in the compose window.
This way you don’t need to click the Send/Receive button to deliver them.

Managing Your Calendar  Inside calendar mode, Evolution provides a con-
venient way to manage your schedule, add new events, and view your
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Figure 3-9 Those of you who have used Microsoft Outlook should find the interface very similar.



 calendar in different ways. When you click the Calendars button to switch to
this mode, you can see the timetable for today as well as the month view. The
month view shows a couple of months in which the bold dates have events.

You can add two types of events to your calendar.

� Meetings: These are events with a specific group of people.

� Appointments: These are general events. 

To add a new appointment, navigate to the date you require using the cal-
endar, then right-click a time slot in the day view, and select New Appoint-
ment. Alternatively, simply click the New toolbar item. In the box that
pops up, fill in the Summary, Location, Time (adjusting the date if neces-
sary), and Description boxes. You can also select which calendar the event
appears on if you have multiple calendars configured.

TIP Multiple Calendars
Evolution supports multiple calendars. This is useful if you want different calendars for dif-
ferent types of events such as personal and work-related activities. To create a new calendar,
right-click the calendar list in the left sidebar and select New Calendar.

To add a new meeting, again find the date, right-click the day view, and
select New Meeting. Inside the dialog box that pops up, you need to add
the participants who are attending the meeting. You can add participants
in two ways: Use the Add button if they are not in your address book, or
use the Attendees button if they are in your address book.

When you click Attendees, a new dialog pops up with a list of attendees
down the left. You can use the Add and Remove buttons to add contacts to
(or remove them from) the different categories of Chairpersons, Required
Participants, Optional Participants, and Resources. Now, you probably
don’t have any contacts in there as you are just starting to use Evolution, so
use the main Contacts button on the left side of the main Evolution win-
dow to add some.

You can view your calendar in lots of different ways by clicking the differ-
ent toolbar buttons such as Week, Month, and List. Play with them and see
which ones are most useful to you.
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QUICK TIP Remember, you can access your appointments without opening Evolution by clicking on the
clock in the panel.

Creating Graphics with GIMP
The GNU Image Manipulation Program, affectionately known as GIMP
to its friends, is a powerful graphics package. GIMP provides a compre-
hensive range of functionality for creating different types of graphics. It
includes tools for selections, drawing, paths, masks, filters, effects, and
more. It also includes a range of templates for different types of media
such as Web banners, different paper sizes, video frames, CD covers, floppy
disk labels, and even toilet paper. Yes, toilet paper. 

Unlike Adobe Photoshop, GIMP does not place all of its windows inside a
single large window; instead, GIMP has a number of separate child win-
dows. This can be a little confusing at first for new users—especially those
used to Photoshop. To get you started, let’s run through a simple session in
GIMP.

An Example  Start GIMP by clicking Applications > Graphics > GNU
Image Manipulation Program.

When GIMP loads, you will see a collection of different windows, as
shown in Figure 3-10.

Close the Tip of the Day window, and you are left with two other windows.
The one on the left in the screenshot is the main tool palette. This window
provides you with a range of different tools that can be used to create your
images. The window on the right provides details of layers, brushes, and
other information. GIMP provides a huge range of different windows that
are used for different things, and these are just two of them.

To create a new image, click File > New. The window shown in Figure 3-11
will appear.

The easiest way to get started is to select one of the many templates. Click
the Template combo box and select 640 × 480. If you click the Advanced
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Figure 3-10 GIMP does not put everything in one window like Adobe Photoshop.

Figure 3-11 Lots of templates are available, including one for toilet paper!



Options expander, you can also select the type of color used in the image
with the Colorspace box and the background fill. The Fill combo box is
useful for either selecting a fill color or having a transparent background.

Click OK, and you will see your new image window (Figure 3-12).

To work on your image, use the tool palette to select which tool you want
to use on the new image window. Each time you click on a tool in the
palette, you see options for the tool appear at the bottom half of the palette
window.

When you click the A button in the palette, it selects the text tool. At the
bottom of the palette, you see the different options. Click the Font button
that looks like an upper and lower case A (like Aa) and select the Sans Bold
font. Now click the up arrow on the Size box, and select the size as 60.
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Figure 3-12 Use the right mouse button on the image to access lots of GIMP
options and features.



Move your mouse over to the empty image window, and you will see the
mouse pointer change to a text carat. Click in the image, and a box pops up
in which you can enter the text to add to the image. Type in “Ubuntu.”
With the text entry still open, click the up arrow on the Size box so the text
fills most of the window. As you can see, you can adjust the text while it is
in the image. When you are happy with the formatting, click Close on the
text entry box. Your image should look a little like Figure 3-13.

Now click the button in the palette with a cross with an arrow on each end.
You can use this to move the text around. Click the black text, and move
the mouse.

Let’s now add an effect filter. GIMP comes with a range of different filters
built in. You can access these by right-clicking the image and selecting the
Filters submenu. 

For our image, right-click the image and select Filters > Blur > Gaussian
Blur. In the Horizontal and Vertical boxes select 5 as the value. Click OK,
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and the blur is applied to your text. Anything in GIMP can be undone by
clicking Edit > Undo or typing Ctrl-Z. Your image should now look like
Figure 3-14.

Now we are going to create another layer and put some text over our
blurred text to create an interesting effect. In your image window, click
Dialogues > Layers. The Layers window now appears (Figure 3-15).

Layers are like clear plastic sheets that can be stacked on top of each other.
They allow you to create some imagery on one layer and then create
another layer on top with some other imagery. When combined, layers can
create complex-looking images that are easily editable because you can
edit layers individually. Currently, our blurred text is one layer. We can add
a new layer by clicking the paper icon in the Layers dialog box. Another
window appears to configure the layer. The defaults are fine (a transparent
layer the size of your image), so click OK.
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Now double-click the black color chip in the palette window and select a
light color. You can do this by moving the mouse in the color range and
then clicking OK when you find a color you like. Now click the text button
from the palette and again add the “Ubuntu” text. When the text is added,
it will be the same size as before. Now use the move tool and position it
over the blurred text. Now you have the word “Ubuntu” with a healthy
glow, as shown in Figure 3-16!

The final step is to crop the image to remove the unused space. Click Tools >
Transform Tools > Crop, and use the mouse to draw around the Ubuntu
word. You can click in the regions near the corners of the selection to
adjust the selection more precisely. Click inside the selection, and the
image will be cropped. To save your work, click File > Save, and enter a file-
name. You can use the Select File Type expander to select from one of the
many different file formats.

Communicating with Pidgin
With the Internet steamrolling its way across the world, the ubiquitous
global network has become a part of everyday life and something you can
reasonably assume people have access to. This has in turn spawned a range
of Web-based services and, interestingly, a variety of methods for commu-
nicating with each other.
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Figure 3-15 Layers are essential when creating complex images with lots of parts.



Included with Ubuntu is Pidgin (formerly known as Gaim), a cornucopia
of different methods for instantly messaging your friends from within a
single program. Instead of having to install a separate client application to
talk to your friends on MSN, AIM, ICQ, and Jabber, Pidgin can do it all in
one place. Pidgin is available by clicking Applications > Internet > Pidgin
Instant Messenger.

Setting Up Your Accounts  When you start Pidgin for the first time, you
will be asked if you want to add an account, as none have been configured
yet. Click the Add button to add a new account, and the Add Account box
appears (Figure 3-17).

QUICK TIP To add or edit accounts at a later date, click Accounts > Add/Edit within Pidgin to access
your account list.
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Figure 3-16 Combining steps as we have done can result in interesting effects
such as this.



This window adjusts which text boxes are available depending on the proto-
col chosen. The different networks available are listed as options in the Pro-
tocol box. To create an account, you will need to have an existing account on
one of the networks. Pidgin allows you to have different accounts on differ-
ent networks running together—you just create a new account for each pro-
tocol—or even multiple accounts on the same network.

When you have selected a protocol, fill in the remaining boxes. The Screen
Name box needs to contain your registered username (or e-mail address
for MSN), and the Password box needs the respective password to be
added. You can also use the Local Alias box to add an interesting name that
is displayed when other people see you online. If you want to configure
any other options, click the Advanced tab.

Using Instant Messaging  With your account(s) set up, Pidgin will auto-
matically sign you in. When you are logged in, your list of contacts (known
as buddies in Pidgin) is displayed (Figure 3-18). Additionally, a little icon
will appear in the notification areas that will show that Pidgin is running,
your status, and if you have received any messages.
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Figure 3-17 Pidgin supports many different types of accounts (MSN, AIM, Jabber,
ICQ, IRC, and so on).



You can use the Buddies menu option to add more buddies to the list with
the Add Buddy option. To speak with a buddy, double-click the name, and
a window will pop up. To change your status or sign out, click the status
box at the bottom of your Buddy List and select the appropriate option.

Using IRC  Included in Pidgin is support for IRC channels, and it has a
very nice interface for IRC discussion. To use the IRC feature, first create
an account. Next, sign on, and then click Buddies > Add Chat and enter
the IRC channel name in the Channel box. Finally, double-click on the
channel name to go to it.

Cutting-Edge Voice Over IP with Ekiga
Included with Ubuntu is a simple-to-use yet powerful Internet phone
called Ekiga. Formally known as GNOME Meeting, Ekiga lets you make
voice and video calls with other people across the Internet. In addition to
the traditional Microsoft Netmeeting support, Ekiga now supports SIP, a
protocol commonly used to allow people with software phones such as
Ekiga to communicate with people using hardware Voice Over IP phones.
SIP is an industry standard that many hardware phones, software phones,
services, and providers support.
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Figure 3-18 Pidgin provides quick and easy access to your buddies—just click
them to talk!



If you choose to use SIP, calls from one phone to another across the Inter-
net are free. In addition, many providers allow you to make calls to normal
landline phones for very little cost. Ekiga offers you the possibility to call
anyone in the world directly from your computer with little fuss.

You can access Ekiga by clicking Applications > Internet > Ekiga Softphone.

Setting Up  When you first start Ekiga, you are guided through a setup
wizard (Figure 3-19).

Click Forward to get started, and you see the next page (Figure 3-20).

In this box, enter your first and last name (such as Frankie Banger). Click
Forward to continue.

You can now configure an Ekiga.net account (Figure 3-21).

At Ekiga.net, a free SIP service is offered. If you don’t have an account
(which is likely if this is the first time you have used Ekiga), click the Get an
Ekiga.net SIP Account button. Firefox is then loaded, and you can use the
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Figure 3-19 Setting up Ekiga is simple with the setup wizard.



online form to sign up. If you don’t want an account, just select the check-
box in the wizard saying you don’t want to sign up. If you do sign up, add
your username and password, and then click Forward.

Now you can configure your connection type (Figure 3-22).
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Figure 3-20 Adding your name makes it easier for people to find you online.

Figure 3-21 Ekiga.net offers a free SIP service.



Select the type of connection you have, and then click Forward.

Traditionally, one of the problems in the past with Internet phones has been
that you need to modify your firewall (if you are running one) to get the
phone working. This typically involved configuring your Network Address
Translation (NAT) settings. Luckily, Ekiga can detect the type of NAT set-
tings that you need (Figure 3-23).

After a few seconds of detecting your type of NAT, Ekiga will propose an
option. Click Yes to continue, and then click Forward.

Next, configure your audio (Figure 3-24).

Select ALSA from the box, and click Forward to continue.

You can now select the audio input and output devices (Figure 3-25).

These settings are used to ensure that you can hear and record the audio. To
test your settings, click Test Settings. If all is fine, click Forward to continue.

Next select the type of video manager (Figure 3-26).
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Figure 3-22 Be honest here—selecting a faster speed won’t make it any quicker!
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Figure 3-23 Traditionally, setting up NAT with Internet phones was a pain—until now.

Figure 3-24 Ubuntu supports different types of audio frameworks, but the
Advanced Linux Sound Architecture (ALSA) is the most common.
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Figure 3-26 Ubuntu supports different types of video, but V4L is the most common.

Figure 3-25 Make sure you get these settings right, or you won’t hear anything.



The video manager ensures that video is displayed correctly on your
screen. Select V4L from the list, and click Forward to continue.

The final setting to configure is your Web camera (Figure 3-27).

Ensure that your camera is plugged in, and select a device from the combo
box. If you can’t see any options, you will need to configure your camera
driver first. When you have selected a device, click Test Settings to verify
that it works.

Finally, a summary of your options is displayed (Figure 3-28).

Ekiga is now configured. Click apply!

Making a Call  With the configuration wizard complete, the main Ekiga
window is displayed (Figure 3-29).
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Figure 3-27 Remember to look your best online!



You are now ready to make a call. Simply enter the phone number or SIP
address of the person you want to call, and click the Connect button next
to the address bar. The call is then connected, and you can begin talking.

On the left side of the window are a number of icons that do different things.
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Figure 3-29 The Ekiga window is simple and sleek.

Figure 3-28 Now you are all set to make calls.



� Text Chat: When in a chat, click this icon to open the text chat
window. You can use this to send text messages to the user.

� View Mode: Click this icon to select which view mode Ekiga is in. You
typically need this when in a video chat with someone.

� Address Book: Click this icon to access the address book. Here you
can save your contacts, and you can also access the Ekiga.net online
white pages to see who else is online.

� View Webcam: This icon switches on the Webcam so that you can see
the person you are speaking to.

In addition to these icons, there are some tabs located below the numeric
keypad. Click these tabs to configure the audio and video settings for Ekiga.

Exploring the Ubuntu Landscape
Unlike many other operating systems, Ubuntu includes a comprehensive
suite of applications right inside the system. This range of tools has been
selected to allow you to install Ubuntu and get your work done, communi-
cate with other people, read and create documents, watch and/or listen to
media, and more. Unfortunately, due to space restrictions, this book can
only skim over the surface of available applications.

To help remedy this a bit, here is a quick summary of many of the applica-
tions included on the Applications menu in Ubuntu, including how to
find the applications and a brief description.

� Text Editor

Applications > Accessories > Text Editor

This simple, yet powerful, text editor is ideal for editing documents,
making quick notes, and programming. Included is a range of plug-
ins for spell checking, statistics, file listings, and more.

� Calculator

Applications > Accessories > Calculator

For those times when you need to figure out a percentage or calculate
whether you are getting a raw deal from your employer, the calculator
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is there. It provides a range of functionality for simple and scientific
calculations.

� Terminal

Applications > Accessories > Terminal

Underpinning the desktop is an incredibly powerful command-line
core. This application puts a window around a command-line
interface and allows you to configure transparency, fonts, behavior,
and more. Essential for the command-line junkies among you.

� Gnometris

Applications > Games > Gnometris

If you have too much time on your hands, a surefire way to waste it is
to play this version of Tetris. If you decide that single-player Tetris is
not enough, go and download gtetrinet with the Add/Remove
programs.

� Nibbles

Applications > Games > Nibbles

The classic worm game comes to Ubuntu. Another surefire way to
while away an afternoon.

� Mahjongg

Applications > Games > Mahjongg

For those of you who actually understand the rules of Mahjongg, this
application provides a great implementation of the game.

� FreeCell Solitaire

Applications > Games > FreeCell Solitaire

There is a body of thinking that suggests that FreeCell may be
responsible for untold hours of lost productivity. If you are impatient
about playing Patience, select FreeCell Solitaire.
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� Movie Player

Applications > Sound & Video > Movie Player

Although listed as a movie player, this application actually plays a
range of different types of media, including both video and audio.

� Sound Recorder

Applications > Sound & Video > Sound Recorder

If you need to record something, such as your voice for a podcast or
audio message, you can use this simple tool.

� System Monitor

System > Administration > System Monitor

To get an idea of the current performance or load on your computer,
click on this tool. The System Monitor lets you know which
applications are running and how much memory/processing power
they are using, and it also allows you to kill or restart processes that
are hogging the resources.

� Sudoku

Applications > Games > Sudoku

The increasingly popular logic game arrives on Ubuntu.

� Disk Usage Analyzer

Applications > Accessories > Disk Usage Analyzer

Bits and bytes never looked so good! In case you were wondering
exactly where all your disk space had gone, this will help solve the
mystery.

� F-Spot Photo Manager

Applications > Graphics > F-Spot Photo Manager

Manage your photos, download off your camera, and send them up
to Flickr and other online photo sites.
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Other Applications to Try  There are literally thousands of available pack-
ages that can be installed on your Ubuntu computer. These packages span
a range of different areas, and this section covers some of the popular
ones. Coverage of software installation appears in Chapter 4. Try the fol-
lowing useful applications.

� Blender

Package to install: blender

Blender (Figure 3-30) is an incredibly powerful 3D modeling,
animation, rendering, and production studio. Blender amasses an
impressive range of functionality for creating photorealistic scenes,
animations, and real-time virtual walkthroughs. Blender is also fully
scriptable in Python.

� Inkscape

Package to install: inkscape

Inkscape (Figure 3-31) is a drawing package for creating Scalable
Vector Graphics (SVG). Ever since the SVG format was introduced, it
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Figure 3-30 Blender



has taken the design world by storm. SVG allows the creation of
graphics that can scale to any size. Inkscape is a hugely flexible tool
for creating such graphics, and a huge range of icons and artwork in
open source projects are made in Inkscape.

� Beagle

Package to install: beagle

Beagle (Figure 3-32) is a search system that indexes virtually
everything. After you install Beagle, you can search for “campfire,”
and it will return documents, images, Web pages, blog entries, instant
messaging conversations, and more that contain that term. Beagle is
still very much in development but is an incredibly useful tool.

� Bluefish

Package to install: bluefish

For those of you who want to create Web pages but prefer to write
code, Bluefish (Figure 3-33) is an excellent Web editor. Bluefish is a
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Figure 3-32 Beagle

Figure 3-33 Bluefish



lightweight but feature-rich editor with support for a range of
languages as well as HTML and CSS.

� Audio CD Extractor

Package to install: sound-juicer

Many of us have legally purchased compact disks that we would like
to listen to using our computer or portable music player. Audio CD
Extractor (Figure 3-34) will help you record the songs to your hard
drive so you may do so.
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Figure 3-34 Sound Juicer: An Audio CD Extractor



The Ubuntu File Chooser and Bookmarks
One area in which the GNOME developers have worked hard is in creating
an intuitive and useful file chooser that is accessed in applications with File >
Open. You may be wondering why they have spent so much time on such a
small and seemingly insignificant part of the desktop. In reality, however,
finding files is one of the most frustrating aspects of using computers and
often involves digging through folder after folder to find what you need.
Luckily, the GNOME file chooser (Figure 3-35) helps cut down much of
this file hunting significantly.

The listing of files on the right-hand side is used to find the file you need,
and you can click on folders in this listing to traverse deeper into your sub-
folders. Note how each folder is displayed above the listing in a series of
buttons. You can click these buttons to easily jump back to parent folders
when needed.

Aside from enabling you to manually pick files, the chooser also supports
bookmarks. On the left side of the chooser is a list of devices and bookmarks
labeled Places. These include your home directory (shown as your user-
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Figure 3-35 The file chooser has a number of subtle features such as bookmarks.



name), Desktop (the files on your desktop), and File System (the entire hard
drive), as well as devices such as CD drives, floppy drives, and USB sticks.

To create your own bookmark, use the listing on the right to find the folder
that you want to bookmark, single-click it, and then click Add below the
Places box. The folder now appears in your bookmarks. Now whenever
you need to access that folder, just click the bookmark! In addition to put-
ting the bookmark in the file chooser, it is also available in other parts of
the desktop, such as the Places menu and in the file manager.

Ubuntu in Your Language
When you installed Ubuntu, you were asked which language the system
should use. Although this sets the initial language for the system, you may
want to change the language at a later date. To do this, click System >
Administration > Language Support.

Ubuntu supports a huge range of different languages, and many applica-
tions include a Translate This Application menu option in the Help menu
so that all Ubuntu users can contribute translations in their language(s). If
you would like to help with this effort, it is a fantastic contribution to the
Ubuntu project.

When the language selector first loads, it may ask you to update your lan-
guage packs. Just click Yes to continue. Inside the dialog box a number of
languages are listed, each of which has a Support checkbox listed next to it.
For each language that you want available on the system, check the rele-
vant boxes.

When you have selected the boxes, click the Apply button, and the appro-
priate language packs are downloaded and installed. Now use the Default
Language combo box to choose the new language. You need to log out and
log back in for the changes to take effect.

TIP Choosing a New Language
When you see the login screen, you can use the Language button to choose a language for
that specific login session. When you select the language, you are asked if you want to make
it the default language or use it just for that specific session.
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Customizing Ubuntu’s Look and Feel
Whenever we put someone in front of Ubuntu for the first time, there
seems to be a uniform natural desire to tweak the look and feel of the desk-
top. It can be fun tweaking our desktops so they look just right, and
Ubuntu has great support for all kinds of adjustments. Do you want dif-
ferent-looking applications with a lime green background and crazy fonts?
No problem; just don’t show it to anyone else. . . .

Changing the Background
To change the background of your desktop, right-click it and select
Change Desktop Background. Inside the dialog box that appears, choose
your wallpaper by clicking on an image, and the desktop background will
automatically change. Ubuntu comes with a limited range of pre-installed
wallpapers, so it is likely that you will want to add your own wallpaper. To
do this, save your wallpaper somewhere on your computer, and then use
the Add Wallpaper button to select it. The new wallpaper can be selected
from the list.

If you are not really a wallpaper kind of person and would prefer just a
color for the background, you can use the Desktop Colors controls at the
bottom of the dialog box. The combo box provides three different types of
background: Solid Color, Horizontal Gradient, and Vertical Gradient. Next
to the combo box, click on the color chip to select the relevant color(s).

Changing the Theme
When you are using your applications, the visual appearance of the but-
tons, scroll bars, widgets, and other bits and pieces are controlled by the
theme. The built-in theming system can make your applications look radi-
cally different, and Ubuntu ships with a number of themes that you can try.

Choosing a New Theme  To choose a new theme, click System > Prefer-
ences > Appearance and then click on the Theme tab. Inside the tab that
pops up are a number of themes that you can choose. Just click on a
theme, and the desktop will be adjusted automatically. You can further
customize your theme by clicking the Customize button. A new dialog box
appears that has tabs for the different parts of the theme you can config-
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ure. Click each tab, and select an entry from the list to create your own per-
fect theme.

Installing New Themes  To install a new theme, first head over to http://
art.gnome.org and find a theme that you like. You need to look for Appli-
cation Themes when browsing the site. When you find a theme that you
like, download it to your computer. Now Click System > Preferences >
Appearance, and click the Install button in the Theme tab. Using the file
chooser, find the theme that you just downloaded, and it will install auto-
matically. Now select your new theme from the list.

Configuring a Screensaver
To choose a different screensaver, click System > Preferences > Screen-
saver. The screensaver configuration tool then loads (Figure 3-36).

On the left side of the window is a list of available screensavers. Click on a
screensaver and you will see a preview appear in the space to the right of
the list. You can then use the slider to select how long the computer needs
to be idle before the screensaver kicks in.
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Figure 3-36 A number of screensavers are bundled with Ubuntu.
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The Lock Screen When Screensaver Is Active checkbox can be selected to
lock the screen when the screensaver starts and, as such, requires a user to
enter the password to reactivate the desktop. This is useful if you work in
an office and want to ensure that no one tampers with your computer
when you are away.

Managing Your Files
Files are the tofu and potatoes of any computer, and they need to be man-
aged, copied, moved, renamed, grouped, and loaded. Included with Ubuntu
is a powerful yet simple file manager called Nautilus that integrates tightly
into your desktop. You’ll use it all the time even if you don’t often see the
name.

Nautilus makes extensive use of drag and drop. Unlike the kind of file
manager used in Windows with its tree view and listing of files, Nautilus
displays files in a series of windows in which you can drag files around eas-
ily. For those who just can’t say goodbye to the tree view, Nautilus also sup-
ports that. Aside from providing a simpler user interface, Nautilus also
includes a number of useful features such as video and image previews,
emblems, bookmarks, permissions management, and more.

How Linux Stores and Organizes Files
Before we use Nautilus, it is worthwhile to have a crash course in how files
and folders are organized on a Linux system. If you have not used Linux
before, this is likely to be new to you because the layout is quite different
from Windows and Mac OS X.

TIP Folders and Directories
When reading about file management, don’t get confused by the terms folders and directo-
ries—both words describe the same thing.

In the Windows world, each disk drive is labeled with an identifying letter
such as C: for your hard disk and A: for the floppy drive. In the Linux
world, however, everything is part of the same filesystem organization. As
such, if you have two or three hard disks, a CD drive, and a USB stick all
plugged in, they will all be part of the same folder structure.
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The diagram shown in Figure 3-37 should give you an idea of how every-
thing hangs together.

Right at the top of the tree is the root folder, referred to as /. Inside this
folder are a number of special system folders, each with a specific use. As
an example, the /home folder contains a number of home directories for
each user on the system. As such, the mako user account has the home
folder set to /home/mako.

Which Folder Does What?  The folder structure in a modern Linux distri-
bution such as Ubuntu was largely inspired by the original UNIX founda-
tions that were created by men with large beards. Although you don’t really
need to know what these folders do, since Ubuntu looks after the house-
keeping for you, some of you may be interested in the more important fold-
ers. For your pleasure, we present the Linux folder hit list in Table 3-1.

Configuration Files  In Table 3-1, /etc is described as storing systemwide
configuration files for your computer. Aside from these files that affect
everyone, there are also configuration files for each specific user. Earlier,
when you customized Ubuntu’s look and feel, the settings were applied
only to your current user account. So where are those settings stored?

Inside your home directory are a number of folders that begin with a dot
(.), such as .gnome2 and .openoffice2. These folders contain the configu-
ration settings for specific applications for that specific user. By default,
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these dot folders are hidden in Nautilus because you rarely need to access
them. For future reference, you can view these hidden files and folders by
clicking View > Show Hidden Files.

You can start Nautilus from a number of different places, but the easiest
way to launch Nautilus is from the Places menu. Click on Places > Home
Folder to load your home folder. When the folder loads, you should see
something similar to what Figure 3-38 shows.

The Nautilus window is split into two parts. The sidebar shows categories
of information such as bookmarks, folders, emblems (more on these later),
and more. In the main part of the window, you can see the subfolders and
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Table 3-1 Linux Folders

Folder Use

/boot This folder contains important files to boot the computer, including the
bootloader configuration and the kernel.

/dev Each device on your system (such as sound cards, Webcams, etc.) has an
entry in this folder. Each application accesses the device by using the
relevant items inside /dev.

/etc Systemwide configuration files for the software installed on your system
are stored here.

/home Each user account on the system has a home directory that is stored here.

/lib Important system software libraries are stored here. You should never need
to delve into this world of the unknown.

/media Media devices such as CD drives and USB sticks are referenced here when
they are plugged in. More on this later.

/mnt Other devices can be mounted, too. Again, more on this later.

/opt Optional software can be installed here. This folder is usually used when
you want to build your own software. If you don’t build your own
software, you ignore this folder.

/proc/sys Information about the current running status of the system is stored here.

/root This is the home directory for the main superuser.

/sbin Software that should be run only by the superuser is stored here.

/usr General software is installed here.

/var This folder contains log files about the software on your computer.



files in the current folder. By default, Nautilus displays your bookmarks in
the left sidebar and displays the contents of your home folder.

So, let’s play with Nautilus and see what you can do with it. The first impor-
tant skills to learn involve general file management. Many of the tasks you
need to do can be achieved by right-clicking your file/folder and selecting
the relevant option. There are also a number of options in the Edit menu.

First, create a folder right-clicking the main part of the window and select-
ing Create Folder. A folder is added, and you can type in the name of it. If
you change your mind about the name, rename it by right-clicking and
selecting Rename. If you double-click on a folder, you can access it and
perform the same operations within that folder.

QUICK TIP Just as folders and directories are the same thing, so are folders and subfolders . . . well,
almost. When we refer to subfolders, we are referring to folders contained within another
folder. For example, /home is a folder, while we can refer to /home/mako as a subfolder of
/home.
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Figure 3-38 Accessing your home folder files is as simple as clicking Places >
Home Folder.



Nautilus is also flexible in how your files are displayed. You can view the
files and folders as either the default collection of icons or as a list. To
switch to the list view, select View > View As List. You can also configure
the organization of how your files and folders are displayed by right-
clicking the main part of the window and selecting one of the options in
the Arrange Items menu. Play with each of these options to see which ones
work best for you.

QUICK TIP Just like in the file dialog, Nautilus displays each of the different parts of the path as different
buttons. As an example, /home/mako/work would have three buttons: home, mako, and work.

Selecting, Copying, and Moving Files and Folders
Copying and moving files and folders are simple tasks with Nautilus and
can be done in a number of different ways. To test this, create two folders
called Work and Invoices in your home directory. Save some files inside
each folder. You can quickly create empty files by double-clicking the
folder to go into it, right-clicking, selecting Create Document > Empty
File, and renaming the file to something useful. With a couple of folders
now complete with files in them, let’s move them around.

One method is to use two windows. Right-click the Work folder, and select
Open in New Window. You now have two windows open, one with the con-
tents of Work and one with the contents of your home directory. Now copy
the Invoices folder to the Work folder by clicking it and dragging it over to
the second window (which shows the contents of Work). By default, drag-
ging from one window to another copies the item.

Another option is to select what you want to copy and paste it. Selecting
items can again be done in a number of ways. One method is to click each
file/folder while holding down the Shift or Ctrl keys to make multiple selec-
tions. The difference between the two keys is that Shift allows you to select a
number of files and folders next to each other, and Ctrl selects independent
files and folders from anywhere in the folder-listing view. When you have
selected what should be copied, right-click and select Cut or Copy. Cut will
copy the original files but remove them, and Copy will just copy them while
leaving the original files intact. Now go to the destination folder, right-click
it, and select Paste. The files/folders are now added.
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Using the Sidebar
The sidebar in Nautilus can be changed to a variety of views that should
cater to virtually all tastes. Each of these different sidebar views has a range
of functions. Table 3-2 explains each one.

Although you will probably stick with one in particular, it is not uncom-
mon to switch between options to achieve a particular task. For this rea-
son, the flexibility provided by the range of sidebar options is useful.

TIP Drag and Drop
If you want to put something in the Places view, drag and drop the item. The Ubuntu desktop
is filled with drag-and-drop shortcuts like this. If you think something could be dragged and
dropped, try it!

Using Emblems
Emblems give you the ability to tag files and folders to indicate something.
These small graphical icons are used to say that the file/folder falls into a
particular category, visually signified by the emblem. As an example, you
may want to tag a file to indicate it is a draft.

When you select the Emblems sidebar, a range of different emblems
appears. To apply an emblem to a file/folder, just drag the emblem onto it.
You can drag multiple emblems onto the files to indicate multiple things.
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Table 3-2 The Different Nautilus Sidebar Options

Option Feature

Places (Default view) Includes the devices and bookmarks in the sidebar that
you typically see in the file chooser.

Information Displays some limited information about the current folder.

Tree Displays a tree view similar to Windows/Mac OS X. Those of you who
love the way Windows/Mac OS X works may want to use this.

History Displays a history of the folders you have clicked on.

Notes Allows you to write notes in the sidebar that are stored in the folder.
This is handy when you need to explain or make comments about the
current folder.

Emblems Lists the files and folders that have specific emblems attached. 



Ubuntu and Multimedia
In recent years, multimedia has become an essential part of computing.
Watching DVDs and videos and listening to CDs and music have become
part and parcel of the modern desktop computer experience. These multi-
media capabilities have been further bolstered by the huge popularity of
legal music downloading. With a range of online stores for a variety of dif-
ferent types of music, it is not uncommon to listen to most of your music
without ever seeing a little shiny silver disk.

Installing Codecs
Multimedia files and disks come in a variety of different types, and each
type uses a special codec to compress the content to a smaller size while
retaining a particular level of quality. To play this media, you need to
ensure that you have the relevant codecs installed. Ubuntu now makes this
easier by suggesting packages that provide a suitable codec when you open
a file that isn’t supported by the ones that are currently installed. Simply
double-click the file you want to open, and you should be provided with a
list of packages that you can install to enable support for the file you have
tried to open. Select the packages that seem appropriate, and click Install.

QUICK TIP If you double-click a file but no packages are suggested, you may need to change the pack-
age filter in the top right-hand corner to All Available Applications.

Codecs still remain a problem for open source software because of the
legal restrictions placed upon them. Certain codecs (including MP3, Win-
dows Media Format, QuickTime, and RealMedia) are proprietary and as
such have restrictions placed on their use, distribution, and licensing.

Although developers in the open source community have gone away and
created free implementations of some of these codecs, the licensing that
surrounds them conflicts with the legal and philosophical position that
Ubuntu has set. These codecs are not included not only because they are
legally dubious but also because they disagree with Ubuntu’s ethic of cre-
ating a distribution that is entirely comprised of free software in the freest
sense of the word.
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QUICK TIP If you want to find out more about installing these codecs, see https://wiki.ubuntu.com/
RestrictedFormats.

To work toward resolving these problems, a number of developers are work-
ing on free codecs such as Ogg Vorbis and Ogg Theora that provide high-
quality results and open licensing. The Ogg Vorbis codec is used on audio
and can provide better results than MP3 at a smaller file size. The Ogg
Theora codec is used for video and competes with the MPEG-4 codec.
Ubuntu includes the Ogg Vorbis and Ogg Theora codecs by default, and you
can encode and play back any media that uses those codecs out of the box.

Although the world would be a better place if all codecs were free, the real-
ity is different, and many Ubuntu users still want to play media com-
pressed with proprietary codecs. Table 3-3 shows the most typical codecs
used to encode and play back media and lists their support in Ubuntu.

Listening to Audio Files
Ubuntu includes a powerful music player called Rhythmbox to organize
and play your music file collection. By default, Ubuntu will look for music
in the Music directory accessible in the Places menu.
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Table 3-3 Codec Support

Codec File Type Included Supported

MP3 .MP3 No Yes

Ogg .ogg Yes N/A

Windows Media Audio .wma No Yes*

Wave .wav Yes N/A

MPEG-1 .mpg No Yes

MPEG-2 .mpg No Yes

Raw DV .dv Yes N/A

Quicktime .mov No Yes*

Windows Media Video .wmv No Yes*

* These codecs involve the installation of nonfree software that may or may not be legal in
your country.
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Using Rhythmbox  Load Rhythmbox (Figure 3-39) by clicking on Applica-
tions > Sound & Video > Rhythmbox Music Player. The Rhythmbox window
is split into a number of different panes, each displaying different details
about your music collection. The left pane (Source) lets you select the source
of the music, such as your media library, podcasts, and Internet radio. Each of
these options has a browser pane available to display the source of the con-
tent. As an example, when you use the Library, one pane displays the artists
and one displays the albums. You can use this to navigate your music.

Listening to Podcasts  Podcasts are audio shows that you can subscribe
to, and they are increasingly becoming the new way to listen to audio and
music. When you subscribe to a podcast, each new release is automatically
downloaded for you. This makes it extremely convenient to regularly lis-
ten to audio shows.

If you are new to podcasting, you should grab yourself a podcast feed of
something you like. A site such as www.podcast.net is a good place to start.
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Figure 3-39 Rhythmbox is a great place to look after your music collection.
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Go to the site in Firefox, and when you see a link that indicates a podcast
feed or RSS feed, right-click it and select Copy Link Location.

Rhythmbox has good support for Podcast feeds, and subscribing to a feed
is simple. In the sidebar, right-click the Podcasts entry and click New Pod-
cast Feed. Paste in the feed by right-clicking the box and selecting Paste.
The files are automatically downloaded, and you can listen to them by
double-clicking on them. Each time you start Rhythmbox, a check is made
to see if any new episodes exist, and if so, they are downloaded.

NOTE Rhythmbox and iPods
Rhythmbox can also read songs from your iPod—just plug it in and it will display in Rhythmbox.
Rhythmbox can read from the iPod but may not be able to write to all iPods..

Playing and Ripping CDs
When you pop a CD into your CD drive, Audio CD Extractor (Sound
Juicer) automatically loads to play your CD. If you are connected to the
Internet, the CD is looked up on the Internet, and the album details and
song titles are displayed.

Ripping Songs as Oggs  Sound Juicer is not just a CD player but a ripper
too. Using a ripper you can convert the songs on the CD into files that you
can play on your computer. By default, Sound Juicer rips the files in the
Ogg format, which provides better sound quality than MP3 at a smaller
size. By default, the ripped files are stored in the format discussed earlier,
with each artist as a folder and albums as subfolders.

To rip the songs, just select the checkboxes of the songs you want ripped
(by default, all songs are selected), and then click Extract. Each song is
then stored in your Music folder, and the song titles are used as the names
of the files.

Ripping Songs as MP3s  Although the default Ogg support is recom-
mended in most situations, you may prefer to rip MP3 files if you have a
digital audio player that does not support Ogg files. To do this, you need to
configure Sound Juicer to enable MP3 support.
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You should first install the gstreamer0.10-plugins-ugly-multiverse pack-
age (see Chapter 4 for more details on installing packages). Next, in Sound
Juicer, click Edit > Preferences and choose the CD Quality, MP3 (MP3
audio) profile from the Output Format options.

Watching Videos
To watch videos in Ubuntu, you need to ensure that you have the correct
codecs installed. As discussed earlier, some of these codecs are available
separately due to the legal implications of including them with the
Ubuntu system. Although the new process for suggesting and installing
codecs should cover most popular types of files, you should still refer to
the Ubuntu wiki at http://wiki.ubuntu.com for details of how to install
ones that are not recognized.

Using Totem  To watch videos in Ubuntu, you use the Totem media player
(Figure 3-40). Load it by clicking Applications > Sound & Video > Movie
Player.
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Figure 3-40 Totem is a simple and flexible media player.
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To watch a video on your hard disk, click Movie > Open, and select the file
from the disk.

TIP Another Way to Load Files into Totem
You can also load multimedia files into Totem by double-clicking them on your desktop or in
the file manager.

Totem also supports video streams. To watch a stream, click Movie > Open
Location, and enter the Internet address for the stream. The video feed is
then loaded and displayed.

Getting DVDs to Work  Ubuntu comes with DVD support for unen-
crypted DVDs. With the DVD industry being what it is, the majority of
DVDs come encrypted, and if you want to watch them, you need to ensure
that a library that can decrypt these DVDs is installed. Unfortunately, this
library needs to be installed separately and is not included with Ubuntu.
Refer to the Ubuntu wiki restricted formats page at https://wiki.ubuntu.
com/RestrictedFormats for details.

With the library installed, insert a disk into your computer, and Ubuntu
will automatically start Totem to view the disk. Alternatively, fire up
Totem, and click Movie > Play Disk to play the DVD. Totem doesn’t sup-
port DVD menus but you can still use it to play a DVD.

If you are settling down to watch a movie, you may want to configure a few
other settings. First click View > Aspect Ratio to select the correct aspect
ratio for your screen, and then select View > Fullscreen to switch to full
screen mode. To exit full screen, just move your mouse, and some on-
screen controls will appear.

TIP Control Totem with a Remote Control
Totem supports the Linux Infrared Control (LIRC) library so you can use a remote control
while watching your media.

Summary
In this chapter you’ve learned how to start using the core features of your
new desktop. These concepts should allow you to perform most of the
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day-to-day tasks when using your computer and provide a base from
which to explore the other applications installed on your system. This
solid grounding in the desktop paves the way for you to meander through
the rest of the book, learning about the more advanced uses of your new
system and exploring the enormous flexibility that Ubuntu provides.

Always remember that there is a wealth of help and documentation avail-
able online. If you ever find yourself stuck, take a look at the Ubuntu
Web site at www.ubuntu.com or the Ubuntu documentation at http://
help.ubuntu.com and make use of the forums, wiki, mailing lists, and IRC
channels.
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Kubuntu, 277
Ubuntu. See Installing Ubuntu, alternate

install CD.
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command-line interface, 96
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description, 95
Disk Usage Analyzer, 97
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APT (Advanced Package Tool)
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Array management. See LVM (Logical Volume
Manager).
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At sign (@), in command-line username,

393–394
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CDs. See CDs, audio.
configuration, Ekiga, 90, 91–92
distortion, 208
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iPods, 115
MP3 format, 112, 115–116
Ogg Theora, 113
Ogg Vorbis, 113
playing, 97, 113–116
podcasts, 114
previewing sound files, 194
problems with. See Troubleshooting,

multimedia.
Rhythmbox, 113–115
Sound Recorder, 97
sound recording, 97
sound server, default, 207

Audio CD Extractor, 101, 115
Authentication, Kubuntu, 290
Authentication tab, 290
auth.log, 175
Automatic login, 199, 315–316
Autopackages, 196–197
Avatars, Ubuntu Forums, 390
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Backing up data. See also RAID (redundant
array of inexpensive disks).

boot sector, 188
incremental backups, 140
before installing RAID, 153
prior to installation, 39

strategies for, 139–140
tools for, 140

Backports repository, 161–162, 167
Bacon, Jono, 244
Baker, 132
Banshee, Ubuntu/Windows equivalent, 408
Base, Ubuntu/Windows equivalent, 408
Basinger, Mike, 265
Bazaar, 27, 379
Beagle, 99–100
Beep Media Player, Ubuntu/Windows

equivalent, 408
Binary uploads, Ubuntu archive, 168
BIOS configuration problems, 39
BitLocker, Ubuntu equivalent, 158
Blank desktop area, 60
Blanking screens, 357
Blender, 98, 410
Blinken, 329
Blogs, 71
Bluefish, 99–101
Blueprint, 28, 377
Bluetooth, 218
Bochs, virtualization, 179
Bookmarking Web pages, Konqueror, 305
Bookmarks

files and folders, 102–103, 111
live, 71
tagging, 70
Web sites, 70–71

Books and publications
The Linux Documentation Project, 405
A Practical Guide to Linux® Commands..., 405
Ubuntu Foundation documentation, 18–24

Boot failure, troubleshooting, 187–188
/boot folder, 108
Boot logo appears corrupted, 189
Boot sector. See also MBR.

backing up and restoring, 188
corruption, 187
troubleshooting, 187–188
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“Bootable flag” setting, 54
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files, 300
the Web. See Web browsers; specific Web
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Bug #1, 24–25
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Bulletin boards. See The Fridge; IRC (Internet
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Burger, Corey, 265
Burn from Disk Image option, 38
Burning CDs. See CDs, burning.
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Hide/Show Desktop, 65
thin white line, 60
white cross, 60
white square, 60
in window border, 60

Calc program, 304, 407
Calculator program, 95–96
Calculators

Calc program, 304, 407
Calculator program, 95–96
Kubuntu, 304, 313

Calendar mode, Kubuntu, 310–311

Calendars. See also Kontact; KOrganizer.
accessing from the clock, 65, 79
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Kubuntu. See Kontact; KOrganizer.
meetings, 78
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Canonical, definition, 12
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founding of, 11–12, 25–26
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service and support, 26–27
version control tool, 27
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command.
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cd command, 395, 397
CD images. See .iso files.
CD/DVD Burner, 131
CD/DVD burners

accessing, 131
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GNOME Baker, 132
ISO Recorder, 37
Nero Burning ROM, 37

CD-ROMs, 217
CDs

alternate install. See Installing Ubuntu,
alternate install CD.

audio. See also Audio.
burning, 306
Kubuntu, 294
playing, 115–116
ripping, 115–116
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burning. See also CD/DVD burners.
accessing the burner, 131
audio and data, 306
Burn from Disk Image option, 38
vs. copying, 38
from images, 36, 131–132
installation image files, 36
.iso files, 36, 132
K3b program, 283, 306–307
Kubuntu, 283
in Linux, 38
in Mac OS X, 38
in Windows, 37

copying. See CDs, burning.
desktop. See Installing Ubuntu, desktop CD.
installation. See Installation CDs.

Celestia, Ubuntu/Windows equivalent, 410
Changing directories, 395
Chats. See also Mailing lists; Ubuntu Forums;

Web forums; Wikis.
IRC (Internet Relay Chat)

about Edubuntu, 362
about Kubuntu, 308
description, 248–249
FreeNode IRC network, 248
list of channels, 249
Pidgin, 87

text chat, Ekiga, 95
Chief gnuisance, 371
chmod command, 399
chown command, 399
Client management, Edubuntu

kernel version, determining, 354
kernel version, updating, 353–355
NFS root, updating, 352–353

Client setup, LTSP, 339–340
Clock

calendar access, 65, 79
description, 65
LTSP, 337–338

setting, 337–338
UTC (Coordinated Universal Time), 337–338

Closing applications, 60
Cloud computing, 181–182
CoC (Code of Conduct), 20–22
Code revisions, approving, 264
Codecs, 112–113, 116
Coffee references, Ubuntu Forums, 390
Colors, image editing, 84
Command line access, Kubuntu, 313
Command-line, package management tools,

162–163
Command-line interface. See Terminal.
Commands

help for. See Man pages.
scheduling. See cron system; crontab command.
syntax and usage. See specific commands.

Comment lines, in APT, 162
Commercial distributions, 371
Communicating with developers. See Ubuntu

community, communication venues.
Community Council, 263–265
Community of users. See Ubuntu community.
Compiling applications, 197–198
Compression, multimedia. See Codecs.
Computer administration

customizing your system. See Customizing.
Kubuntu. See Kubuntu, customizing;

Kubuntu, system administration;
Software Management.

troubleshooting. See Troubleshooting, system
administration.

Computer Administration section, 293
Computer menu item, 62
Computer tab, 283
Computers

names, configuring in Kubuntu, 281
older or less powerful. See Installing Ubuntu,

alternate install CD; U-lite; Xubuntu.
supported by Ubuntu, 34–35
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Conferences, 257–259
Configuration settings, folders for, 107
Configuring. See also Customizing.

BIOS, 39
desktop area, Ubuntu

background, 104
the clock, 65
menus, 61–62
screensavers, 105–106
themes, 104–105
wallpaper, 104

Edubuntu server. See Edubuntu, server
management.

keyboard layout. See Keyboards, configuring.
printers

adding printers, 134
driver, specifying, 135–136
gathering information, 134
New Printer wizard, 135–136
Printer configuration application, 133–134
printer model, specifying, 135–136
printing a test page, 136
remote printing, 136–137

Connect to Server menu item, 63
Contacting Ubuntu developers and users. See

Ubuntu community, communication
venues.

Containerization, 179
Context menu for applications, viewing, 66
Cool Streams, 303
Coordinated Universal Time (UTC), 337–338
Copying

CDs, vs. burning, 38
files

between computers, 63, 226
cp command, 398
overview, 110
scp command, 226
to/from USB storage, 215–216

folders, 110
photos from mobile phone, 218

Copyright violations, 205–206, 303

Core philosophical ideals, 18–20
cp command, 398
cron system, 223–226
crontab command, 223–226
Cropping images, 84
Ctrl-Alt-Backspace restart, 199
Cunningham, Ward, 251
Custom server kernel, 147
Customizing. See also Configuring.

the clock, 65
desktop area, Ubuntu

background, 104
the clock, 65
menus, 61–62
screensavers, 105–106
themes, 104–105
wallpaper, 104

Kubuntu. See also Kubuntu, system
administration; Kubuntu, system
settings.

accessibility options, 293
desktop. See Plasma.
GHNS (Get Hot New Stuff), 286–287
KMenu style, reverting to, 285
ksplash, 292
locking the screen, 284
making immutable, 312–313
password, 284
splash screen, 292

look and feel. See Themes and backgrounds.
menus, 61–62
screensavers, 105

CVE numbers, 127–128

Data replication, RAID, 151
Databases

Base program, 408
IBM DB2 database, Ubuntu support, 26
of stars, 326–327
Ubuntu/Windows equivalent, 408

Date and time. See Clock.
dd command, 188
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.deb file extension, 162
Debian package manager, 162–163
Debian project, 16–17
debmirror, 194
deborphan tool, 170
Debs, 162
DEFAULT keyword, LTSP, 343
Degraded mode, RAID, 154
Deleted items, restoring, 195
Deleting. See also Removing.

files, 398
partitions, 52
user accounts, 172, 401–402
user groups, 402

delgroup command, 402
Dell laptops, Ubuntu support, 26
deluser command, 172, 402
Derivatives of Ubuntu, 30–31
Derived distributions. See also Distributions.

for the Andalusian government, 370–371
commercial distributions, 371
gNewSense, 371–372
Guadalinex, 370–371
for low-power computers, 372
Mythbuntu, 211, 369
Nexenta OS, 372
officially supported. See Edubuntu; Kubuntu;

Ubuntu Server Edition.
for the OpenSolaris kernel, 372
overview, 30–31
recognized. See Mythbuntu; Ubuntu Studio;

Xubuntu.
for restricted code, 371
Spanish language, 370–371
Ubuntu Studio, 369–370
Ubuntulite. See U-lite.
U-lite, 372. See also Xubuntu.
Xubuntu, 30, 35, 368–369. See also U-lite.

Desktop area
adding TrueType fonts, 191–192
globes, 329
hung, 198–199

installing a new environment, 193
KDE. See Plasma.
Kubuntu. See Plasma.
performance enhancement, 227–228
speeding up, 227–228

Desktop area, Edubuntu
blanking screens, 357
lockdown editor, 357–358
locking screens, 357
logging users out, 356
overview, 355
Pessulus lockdown editor, 357–358
plug-ins, 358
process management, 356
resolution, 338
sending messages, 357
starting programs, 357
Thin Client Manager, 355–356
user groups, 358

Desktop area, Ubuntu. See also Applications
menu; GNOME.

adding TrueType fonts, 191–192
Administration menu item, 63
appearance. See Themes and backgrounds.
applets, 64
applications

closing, 60
context menu, viewing, 66
hiding/showing, 65
maximizing, 60
minimizing, 60
open, displaying, 65–66
putting in the taskbar, 60
starting, 60–62
switching between, 66

blank desktop area, 60
buttons

Hide/Show Desktop, 65
thin white line, 60
white cross, 60
white square, 60
in window border, 60
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Desktop area, Ubuntu, continued
calendar, 65
clock, 65
Computer menu item, 62
Connect to Server menu item, 63
corner features, 66
customizing

background, 104
the clock, 65
menus, 61–62
screensavers, 105–106
themes, 104–105
wallpaper, 104

Desktop folder, accessing, 62
Desktop menu item, 62
documentation, accessing, 63
drives, displaying, 62
help and support, 63
Help and Support menu item, 63
hiding/showing, 65
Home folder, accessing, 62
Home Folder menu item, 62
icons

adding, 64
in the Desktop folder, 62
for devices, 60
moving, 64
placing on the desktop, 62
shortcuts, 64
starting applications. See Applications

menu.
language selection, 59
locking the screen, 106
look and feel. See Themes and backgrounds.
main areas, 59–60
menus

Applications, 61–62, 66
layout, changing, 61–62
Places, 62–63
System, 63

My Computer, equivalent, 62
My Documents, equivalent, 62

Network menu item, 63
Network Neighborhood, equivalent, 63
notification area, 65
the panel, 59–60
passwords, for Administration features, 63
Preferences menu item, 63
Recent Documents menu item, 63
recently used documents, displaying, 63
Search for Files menu item, 63
servers, connecting to, 63
support, accessing, 63
taskbar, 60, 65–66
trash, 66
usability, 66
virtual desktops, 66
volume control, 65
Windows system tray, equivalent, 65
workspaces, 66

Desktop CD, installing from
Kubuntu, 278–281
Ubuntu. See Installing Ubuntu, desktop 

CD.
Desktop Effects, disabling, 227–228
Desktop folder, accessing, 62
Desktop keyring, 138
Desktop machines vs. servers, 23. See also

Ubuntu Server.
Desktop menu item, 62
Desktop publishing, Ubuntu/Windows

equivalent, 409. See also Word
processing.

Desktop Search configuration, Kubuntu, 
295

Desktop section, 292
/dev folder, 108
Developer blogs, 71
Developer contacts, 251
Developer sprints, 255–257
Developer summits, 255–257
Development discussions. See Blogs; IRC

(Internet Relay Chat); Mailing lists; Web
forums; Wikis.
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Development environment. See IDE (Integrated
Development Environment).

Device configuration files, folder for, 108
Device drivers

finding, 217–218
LIRC, 222–223
printers, specifying, 135–136
restricted, 190
wireless cards, 214–215

Device information, displaying, 111
Devices. See also specific devices.

filesystems, determining, 219–220
names, indicating connection type, 43
network support, determining, 213–215
not working, 217–218
problems with. See Troubleshooting, hardware.
support, determining, 223
system support, determining, 223

df command, 399
DHCP servers, 341–342
Dia, Ubuntu/Windows equivalent, 410
Diagram editing, Ubuntu/Windows equivalent,

410
Digital cameras, 132, 294
Digital flash cards, 329
Digital Millennium Copyright Act (DMCA),

205–206
Digital photography. See Photographs.
Digital Rights Management (DRM), 303
Direct memory access mode (DMA), enabling,

206
Directories. See also Folders; Terminal

commands, files and folders.
changing, 395
vs. folders, 106

Disabled users. See Accessibility.
Disk replication, Ubuntu Server, 180–181
Disk space

freed, viewing, 200
freeing, 200
reducing, 230–231
usage, displaying, 399

Disk storage. See also CDs; USB storage devices.
across physical boundaries. See RAID

(redundant array of inexpensive
disks).

fixing, 230
floppy disks, 132
formatting, 220–221
fsck program, 230
hard disks. See also LVM (Logical Volume

Manager).
partitioning. See Partitioning disks.
usage analysis, 97

mkfs commands, 221
organizing. See Partitioning disks.
reads but won’t write, 218–219
recovering from power failure, 229–230
space usage. See Disk space.
USB keyring devices, 130–131, 138

Disk Usage Analyzer, 97, 200
Diskless clients, 330–332
DISPLAY option, 343
Display section, 293
Display settings, Kubuntu, 293
Displays. See Monitors; Screens.
Dispute arbitration, 264
Distributed Replicated Block Device (DRBD),

181
Distribution management software, 28
Distribution upgrades, Ubuntu Server, 167–168
Distributions. See also Derived distributions;

Repositories; specific distributions.
contents, 13
definition, 12
derived. See Derived distributions.
diversity of, 14–15
educational purposes. See Edubuntu.
with KDE. See Kubuntu.
for older computers. See U-lite; Xubuntu.

Distros. See Distributions.
Distrowatch database, 14
DMA (direct memory access mode), enabling,

206
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DMCA (Digital Millennium Copyright Act),
205–206

dmesg log, 175
Documentation. See also Help; Online

resources; Ubuntu community,
communication venues; Ubuntu
Foundation, documentation

command-line interface. See Man pages.
GNOME desktop, accessing, 63
user involvement, 269

Documents
creating

mathematical expression builder. See Math.
presentations. See Impress.
spreadsheets. See Calc.
word processing. See Desktop publishing;

Word processing.
recently-used, searching for, 63

Dollar sign ($), UNIX shell symbol, 163, 393–394
Dolphin file manager, 297–298
Donating to the Ubuntu project, 29
do-release-upgrade tool, 167
Dot (.) prefix files, 107
Double ampersand (&&), running multiple

commands, 226
dpkg utility, 162–163
Draw program, 304
Drawing package, 329–330
Drawing programs. See also Images (graphic),

editing.
3D modeling, 98, 410
Draw, 304
GIMP (GNU Image Manipulation), 79–84
Inkscape, 98–99
SVG (Scalable Vector Graphics), 98–99
Tux Paint, 329–330
Ubuntu/Windows equivalent, 410

DRBD (Distributed Replicated Block Device),
181

Drivers. See Device drivers.
Drives, displaying on the desktop, 62
DRM (Digital Rights Management), 303

Dual boot
LTSP, 331, 343–345
online resources, 344
partitioning the disk for, 41–43

DVDs
burning. See CD/DVD burners.
DMA (direct memory access mode),

enabling, 206
encryption, video, 117
mounting, 217
not working, 217
online resources, format restrictions, 117
playback is jittery, 206
support, enabling, 210
won’t eject, 217
won’t play, 206

East, Matthew, 265
ecryptfs, 158
Editions of Ubuntu. See Derived distributions;

specific editions.
Edubuntu. See also LTSP (Linux Terminal

Server Project).
adding/removing programs, 346–347
blanking screens, 357
client management

kernel version, determining, 354
kernel version, updating, 353–355
NFS root, updating, 352–353

description, 367–368
desktop management

blanking screens, 357
lockdown editor, 357–358
locking screens, 357
logging users out, 356
overview, 355
Pessulus lockdown editor, 357–358
plug-ins, 358
process management, 356
resolution, 338
sending messages, 357
starting programs, 357
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Thin Client Manager, 355–356
user groups, 358

downloading, 322
first edition, 321
giving back to the community, 362
goals of, 321–322
help, 361–362
history of, 321–322
installing. See Installing Edubuntu.
IRC (Internet Relay Chat), 362
lockdown editor, 357–358
locking screens, 357
logging users out, 356
mailing lists, 361
online resources, 368
overview, 320
Pessulus lockdown editor, 357–358
plug-ins, 358
process management, 356
sending messages, 357
server management

installing applications, 346–347
IP address, changing, 348
local devices, 348–349
password display, 348
printing, 350–351
removing applications, 347
sound, 349–350
SSH keys, updating, 348
update notification, 345
updating the server, 345
window manager alternatives, 351–352

starting programs, 357
Thin Client Manager, 355–356
vs. Ubuntu, 30
user groups, 358
Web forums, 362. See also Ubuntu Forums.
Web sites about, 361

Edubuntu, applications
astronomy, 326–328
desktop globe, 329
desktop publishing, 409

digital flash cards, 329
drawing package, 329–330
educational, 323
function graphing, 326
games

anagram creator, 325
Blinken, 329
GCompris, 330
hangman, 325
Kanagram, 325
KHangman, 325
Simon Says, 329

GCompris Administration, 323
Impress, 304
Kalzium, 324
KmPlot, 326
KStars, 326–328
KTouch, 328
KTurtle, 328
Logo programming language, 328
maps, 329
Marble, 329
math

factoring numbers, 325
fraction exercises, 325
geometrical construction, 325–326
graphing functions, 326
KBruch, 325
Kig, 325–326
KmPlot, 326
plotting, 326

Parley, 329
periodic table exploration, 324
physics simulator, 329
Scribus, 409
space exploration, 326–328
standard, 323
stars database, 326–327
Step, 329
touch typing tutor, 328
Tux Paint, 329–330
world atlas, 329
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edubuntu-devel mailing list, 361–362
edubuntu-users mailing list, 361–362
Education, Ubuntu/Windows equivalent, 410
Educational applications, 323
Educational menu, 323
Education-oriented Ubuntu. See Edubuntu.
Edutainment, Ubuntu/Windows equivalent, 410
Effects filters, image editing, 82–83
802.1x authentication, 213–215
Ejecting CDs and DVDs, 217
Ekiga

address book, accessing, 95
Address Book icon, 95
audio configuration, 90, 91–92
connection type, configuring, 89
description, 87–88
firewall modifications, 90
icons, 94–95
making a call, 93
NAT settings, detecting, 90, 91
Netmeeting support, 87
setting up, 88–93
SIP support, 87–88
starting, 88
text chat, 95
Text Chat icon, 95
video configuration, 90, 92
view mode, selecting, 95
View Mode icon, 95
View Webcam icon, 95
Web camera configuration, 93

Ekiga Softphone, Ubuntu/Windows equivalent,
409

Electrical power
conserving

automatically turning off monitors, 293
hibernating, 68, 158
Kubuntu, 293
monitors, 293
suspending, 67

failure, recovering from, 229–230
Elkner, Jeff, 321

E-mail
accounts, setting up, 74–76
address, configuring, 204
doesn’t work, 204–205
Evolution, 74–77
Hotmail, 75
Kubuntu, 309–310
sending/receiving, 76–77
server setup, 76
troubleshooting, 204–205
Ubuntu/Windows equivalent, 408
unable to connect to server, 77
Webmail, 75
Yahoo! Mail, 75

Emblems, 111
Emblems option, 111
Encryption

DVD, 117
Launchpad, 378
swap partitions, 158
Ubuntu Server, 158–159

Ending a session. See Logging out.
Entertainment, Ubuntu/Windows equivalent,

410
Epiphany, 408
/etc folder, 108
Etrich, Matthias, 274–276
Evolution

calendars, 77–79
e-mail, 74–77
e-mail doesn’t work, 204–205
Hotmail, 75
PIM (personal information manager), 74
Ubuntu/Windows equivalent, 408
Webmail, 75
Yahoo! Mail, 75

Excel, Ubuntu/Windows equivalent, 304, 407
ext3 filesystem, 44–45
Extensions, Firefox, 71–72

Factoring numbers, 325
FAT32 filesystem, 45, 219–220
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Fault tolerance, 150–151, 158
Favorites list, 282
Favorites tab, 282
Feature goals, maintaining, 266
Feature tracking, 28
File associations, Kubuntu, 294
File chooser, 102–103
File formats, Writer, 73–74
File management. See File Manager; Kubuntu,

file management; Nautilus.
File Manager. See also Nautilus.

displaying hidden files and folders, 194–195
freeing disk space, 200
performance, 194
restoring deleted items, 195
running slow, 194
scripting, 202–203
speeding up, 194
viewing freed disk space, 200

Files. See also Folders; Terminal commands, files
and folders.

. (dot) prefix, 107
bookmarking, 102–103
command-line interface to. See Terminal

commands, files and folders.
contents, viewing, 395
copying

between computers, 63, 226
cp command, 398
overview, 110
scp command, 226
to/from USB storage, 215–216
from USB keyrings to the hard disk, 131

copying between computers, 63, 226
deleting, 398
displaying, 110
emblems, 111
execution, prohibiting, 173
finding. See also File Manager; Nautilus.

bookmarks, 102–103
contents, 176, 400
File Chooser, 102–103

grep command, 176
Konqueror, 300
zgrep command, 400

graphical remote access, 137–138
hidden

displaying, 194–195
identifying, 107–108

kioslaves, 300
Kubuntu. See Kubuntu, file management.
last-access log, disabling, 174
listing, 63, 394, 398
moving, 110, 398
owners, finding, 170
ownership, changing, 399
permissions, changing, 399
providers, finding, 170–171
remote access, 137–138
searching for, 63
selecting, 102–103, 110
storing and organizing, 106–109
structure changes, 299–300
transferring over networks, 212
transferring with SSH, 212

Filesystems
creating, 220
default, 44–45
determining, 219–220
ext3, 44–45
FAT16, 45
FAT32, 45, 219–220
hardware issues, 219–220
NTFS, 219–220
optimizing, 54
sharing with Windows, 45
specifying, 54
super-user space, reserving, 54
Ubuntu Server, security, 173

FileVault, Ubuntu equivalent, 158
Filters

graphic, 82–83
packages, 121, 346
user groups, 358
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Finance programs, Ubuntu/Windows
equivalent, 409

Financial support for Ubuntu. See Canonical
Ltd.; Ubuntu Foundation.

Finding. See also Search tools; Searching.
device drivers, 217–218
file owners, 170
file providers, 170–171
files and folders, 63, 300. See also File

Manager; Nautilus.
KPackageKit, 288
packages, 125
recently-used documents, 63
Synaptic, 123
Terminal, 96
themes and backgrounds, 209–210

Finger pain, 241
Firefox

bookmarking sites, 70–71
description, 68–69
extensions, 71–72
Flash is missing, 71–72, 203
Google searches, 70
interface, 68–69
Kubuntu, 306
live bookmarks, 71
navigating the Internet, 69–70
plug-ins, 71–72
searching, 70
starting, 68–69
tabbed browsing, 70
tagging bookmarks, 70
Ubuntu/Windows equivalent, 408

Firewall tables, 176–177
Firewalls, 90, 176–177
Flash, missing from Firefox, 71–72
Flash cards, digital, 329
Flash disks. See USB storage devices, keyring

devices.
Flight Simulator, Ubuntu/Windows equivalent,

410
FlightGear, Ubuntu/Windows equivalent, 410

Floppy disks, mounting/unmounting, 132
Folder access, 283
Folder tree view, displaying, 111
Folders. See also Files.

. (dot) prefix, 107
annotating, 111
/boot, 108
categorizing, 111
changing, 397
command-line interface to. See Terminal

commands, files and folders.
for configuration settings, 107
copying, 110
creating, 109, 399
current, identifying, 397
current, printing, 397
current information, displaying, 111
current system status, 108
definition, 106
/dev, 108
device configuration files, 108
vs. directories, 106
displaying by emblem, 111
emblems, 111
/etc, 108
files in, listing, 394, 398
general software, 108
hidden

displaying, 194–195
identifying, 107–108

history, displaying, 111
/home, 108
/lib, 108
Linux structure, 107–108
log files, 108
/media, 108
media devices, 108
/mnt, 108
mounting devices, 108
moving, 110
/opt, 108
optional software, 108
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ownership, changing, 399
permissions, changing, 399
/proc/sys, 108
/root, 108
/sbin, 108
selecting, 110
subfolders, displaying, 108–109
superuser software, 108
for system configuration files, 108
system libraries, 108
/usr, 108
/var, 108
view, switching, 109
working, printing, 397

Fonts
choosing, 73
Kubuntu, 293
on LCD screen, 192
msttcorefonts package, 190–191
PowerPoint, 190–191
subpixel hinting, 192
TrueType, installing, 191–192
for Windows, 190–191
Word, 190–191

“Format the partition” setting, 54
Formatting disks, 220–221
Forums. See Web forums.
Forums Code of Conduct, 391
Fraction exercises, 325
free command, 399
Free software

access to source code, 4–5
characteristics of, 4
Debian project, 16–17
freedoms, 4
history of Ubuntu, 16–17
meaning of “free,” 4
vs. open source, 6–7
philosophical ideals, 18–20

FREE SPACE line, 52
FreeCell Solitaire, 96
Freedesktop.org standards, 299–300

Freedoms of free software, 4
FreeNode IRC network, 248
The Fridge, 254–255
fsck program, 230
F-Spot Photo Manager, 97, 132
Full virtualization, 179
Function graphing, 326

Gaim. See Pidgin.
Games

anagram creator, 325
Blinken, 329
FreeCell Solitaire, 96
GCompris, 330
Gnometris, 96
hangman, 325
Kanagram, 325
KHangman, 325
Mahjongg, 96
Nibbles, 96
Simon Says, 329
Sudoku, 97
Ubuntu/Windows equivalent, 410

GCompris, 330
GCompris Administration, 323
General chat. See Mailing lists; Wikis.
General software, folder for, 108
General Tab, 292
Geographical location, specifying

from alternate install CD, 48–49
from desktop CD, 39–41
LTSP, 336

Geometrical construction, 325–326
GFS (Global File System), 148
GHNS (Get Hot New Stuff), 286–287
GIMP (GNU Image Manipulation Program),

79–84, 408
GIMP Image Editor, 132
GizmoProject, Ubuntu/Windows equivalent,

409
Globe application, 315
Glom, Ubuntu/Windows equivalent, 408
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gNewSense, 371–372
GNOME, burning CDs/DVDs, 38, 132
GNOME Baker, 132
GNOME desktop. See Desktop area, Ubuntu.
GNOME Meeting. See Ekiga.
Gnometris, 96
GNU General Public License, 275
GNU project, history of Ubuntu, 3–7
Gnucash, Ubuntu/Windows equivalent, 409
Gnumeric, Ubuntu/Windows equivalent, 

407
Goals of

Edubuntu, 321–322
the governance system, 261
Ubuntu

accessibility to disabled users, 20
Bug #1, 24–25
CoC (Code of Conduct), 20–22
philosophical, 18–20
technical, 22–24

Gobuntu. See GNewSense.
Google searches

desktop search box, 70
Firefox, 70
Konqueror, 300, 305
Kubuntu, 300, 305

Governance. See Ubuntu community,
governance system.

Graphical interface fails to start, 190
Graphics. See Drawing programs; Images

(graphic), editing.
Graphing functions, 326
Grawert, Oliver, 321, 355
Green dragon, 275
grep command, 400. See also zgrep

command.
grep tutorials, 401
Grisbi, Ubuntu/Windows equivalent, 409
Group permissions, 173
Groups, user accounts. See User groups.
grsync, 140

Gtranslate. See Rosetta.
Guadalinex, 370–371
Guest Session option, 67
Guided Partitioning option, 337–339
Guided—Use Entire Disk and Set Up Encrypted

LVM option, 51
Guided—Use Entire Disk and Set Up LVM

option, 51
Guided—Use Entire Disk option, 51
Gwenview, 314

HAL devices, listing, 400
Handicapped users. See Accessibility.
Hangman game, 325
Hard disks. See also Disk space; Disk storage;

LVM (Logical Volume Manager).
fixing, 230
partitioning. See Partitioning disks.
power failure, recovering from, 229–230

Hardware. See also specific devices.
detection, from alternate install CD, 49
emulation, 179
listing, 400
troubleshooting. See Troubleshooting,

hardware.
Harmony project, 275
Harrison, Eric, 321
Hash (#), comment indicator, 162
HBD (Here Be Dragons), 8
Hearing-disabled users. See Accessibility.
Help. See also Online resources; Technical

support; Troubleshooting.
for commands. See man pages.
Edubuntu, 361–362
Help and Support menu item, 63
-help command, 402–403
Kubuntu, 316
Terminal commands, 397, 402–403
Ubuntu Forums, 386
Ubuntu Help Center, 63

Hibernate option, 68
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Hibernating, 68, 158
Hidden files and folders

displaying, 194–195
identifying, 107–108

Hide/Show Desktop button, 65
Hiding/showing, applications, 65
Hill, Benjamin Mako, 265
History of

Edubuntu, 321–322
Ubuntu Forums, 382–383

History of Ubuntu. See also Shuttleworth,
Mark.

Debian project, 16–17
first LTS release, 3
first release, 2
free software

and the Debian project, 16–17
and GNU, 3–7
meaning of “free,” 4
vs. open source, 6–7

GNU project, 3–7
Linux, 3–7
LTS (long-term support), 3
open source, 6–7
Open Source Initiative, 6
Perens, Bruce, 6
Raymond, Eric S., 6
Stallman, Richard M., 3–7
Torvalds, Linus, 5
user community, 17–18
Warty Warthog, 2

History option, 111
Holbach, Daniel, 265
Home directory

encryption, 158–159, 172
lockout, 159

/home folder, 108
Home folder, accessing, 62
Home Folder menu item, 62
/home partition, installing Ubuntu Server,

149–150

Hostname, specifying
from alternate install CD, 50
from desktop CD, 45–46

Hotmail, Evolution support for, 75
Hypervisor, 179
Hyphen (-), dash in commands, 225, 395

I386 support, 34
IBM, virtualization, 178–180
IBM DB2 database, Ubuntu support, 26
Icons

adding, 64
in the Desktop folder, 62
for devices, 60
Ekiga, 94–95
moving, 64
placing on the desktop, 62
shortcuts, 64

ICQ, Ubuntu/Windows equivalent, 409
IDE (Integrated Development Environment),

314–315
Ideas and feedback, user involvement, 269
ifconfig command, 400
Illustrator, Ubuntu/Windows equivalent, 410
Image files. See .iso files.
Images (graphic)

editing. See also Drawing programs.
colors, 84
creating a new image, 79–81
cropping, 84
effects filters, 82–83
GIMP (GNU Image Manipulation), 79–84
GIMP Image Editor, 132
Krita, 367
layers, 83
templates for new images, 79–81
text images, 81–84

viewing, 314
Images (of installation CDs). See .iso files.
Immutable desktop area, Kubuntu, 312–313
Impress, 304, 407
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Incremental backups, 140
Information option, 111
Inkscape, 98–99, 410
Input actions, Kubuntu, 293
Installation CDs

alternate install, 34. See also Installing
Ubuntu, alternate install CD.

burning, 36–38
buying, 36
desktop, 34. See also Installing Ubuntu,

desktop CD.
downloading, 36
.iso files, 36–37
from Linux, 38
from Mac OS X, 38
mail order, 36
from Windows, 37

Installation image files. See .iso files.
Installing. See also Add/Remove Applications.

codecs, 112–113
Netbook Remix, 35
non-Synaptic applications, 196–197. See also

Autopackages.
remote control, 222–223
software on Ubuntu Server, 158–159
splash screens, 209–210
themes and backgrounds, 209–210
without Synaptic, 196–197

Installing applications. See also APT (Advanced
Package Tool).

with Add/Remove Applications, 68, 120–122
application sources. See Repositories.
Edubuntu, 346–347

Installing Edubuntu
as an add-on, 322–323
in a non-LTSP environment, 322–323
prerequisites, 322
update notification, 345

Installing Kubuntu
from the alternate install CD, 277
computer name, configuring, 281

from the desktop CD, 278–281
downloading the image file, 277
keyboard layout, selecting, 280
online resources, 35
partitioning disks, 280
switching from Ubuntu, 278
time zone, selecting, 279
Ubiquity installer program, 278–281
username, configuring, 281

Installing LTSP
administrative permissions, 338
client setup, 339–340
clock, setting, 337–338
DEFAULT keyword, 343
on a desktop installation, 340–341
DHCP servers, 341–342
DISPLAY option, 343
dual boot, 343–345
geographical location, specifying, 336
Guided Partitioning option, 337–339
installation procedure, 336–338
keyboard, configuring, 336
language, specifying, 336
NICs (network interface cards), 334–336,

336–337
partitioning disks, 337–339
PROMPT option, 343
screen resolution, specifying, 338
server configuration, 334–336
server setup, 338–339
switching from Ubuntu, 340
TIMEOUT option, 343
in Ubuntu, 340–341
from Ubuntu alternate CD, 333
user accounts, setting up, 338
UTC (Coordinated Universal Time), 

337–338
Installing packages

Add/Remove Applications, 68, 120–122
apt-get utility, 166
Kubuntu, 287–290
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manually, 163–164
from Ubuntu archive, 166

Installing Ubuntu
AMD64 support, 34
architectures supported, 34–35
ARM support, 35
backing up data, 39
CDs for. See Installation CDs.
choosing a version, 34–35
i386 support, 34
LPIA (low-power Intel architecture) support,

35
PowerPC support, 35
switching from Kubuntu, 278
updates

checking for updates, 128
CVE number, 127–128
limitations, 128
new releases, 128–129
notification of, 127
reviewing updates, 127–128
security vulnerability identifier, 

127–128
security-related, 126, 127–128
smart updates, 128
starting the update, 129–130

from a USB key, 55
Installing Ubuntu, alternate install CD

geographical location, specifying, 
48–49

hardware detection, 49
hostname, specifying, 50
installing a server, 48
language selection, 48
partitioning the disk

adding partitions, 52–53
“Bootable flag” setting, 54
bootable partitions, specifying, 54
deleting partitions, 52
filesystem, specifying, 54
“Format the partition” setting, 54

FREE SPACE line, 52
Guided—Use Entire Disk and Set Up

Encrypted LVM option, 51
Guided—Use Entire Disk and Set Up 

LVM option, 51
Guided—Use Entire Disk option, 51
“Label” setting, 54
labeling partitions, 54
Manual option, 51
mount options, 54
“Mount point” setting, 54
mount points, 54
“Reserved blocks” setting, 54
root partition, creating, 53
settings, 54
“Typical usage” setting, 54
“Use as” setting, 54

time zone, setting, 50
user account configuration, 54

Installing Ubuntu, desktop CD
alongside Windows. See Dual boot.
BIOS configuration problems, 39
geographical location specification, 

39–41
getting the CD. See Installation CDs.
hostname, specifying, 45–46
keyboard configuration, 41
language selection, 39, 40
migrating from previous version, 

46–47
partitioning the disk

adding a partition, 44
default filesystem, 44–45
definition, 41
for dual boot, 41–43
manually, 43–45
minimum number of partitions, 42
mount points, 45
sharing with Windows. See Dual boot.
for Ubuntu only, 42–43

password guidelines, 46
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Installing Ubuntu, desktop CD, continued
system use during installation, 47
user account configuration, 45–46

Installing Ubuntu Server. See also LVM (Logical
Volume Manager); RAID (redundant
array of inexpensive disks).

connecting to another server, 149
/home partition, 149–150
log file, 149
partitioning, 149–150. See also RAID.
vs. regular Ubuntu machine, 147–148
root account, enabling, 159–160
ssh client, 149
switching consoles, 149
/tmp partition, 149
/var partition, 149

Installing Xubuntu, 35
Instant messaging, 86–87, 306–308, 409
Integrated Development Environment (IDE),

314–315
Intel Boot Agents will not boot, 360
Internet dial-up tool, 314
Internet Explorer, Ubuntu/Windows

equivalent, 408
Internet phone. See Ekiga.
IP address, changing in Edubuntu, 348
iPods, 115
iptables command, 176–177
ipvsadm utility, 148
IRC (Internet Relay Chat)

about Edubuntu, 362
about Kubuntu, 308
description, 248–249
FreeNode IRC network, 248
list of channels, 249
Pidgin, 87

Isle of Man, 26, 29
.iso files

burning CDs from, 36, 131–132
definition, 36

downloading, Kubuntu, 277
testing, 196

ISO Recorder, burning CDs/DVDs, 37
iTunes, Ubuntu/Windows equivalent, 408
iwconfig command, 400

Java not installed, 203
jdong (Ubuntu Forums denizen), 389

K Control Center. See Software Management,
System Settings.

K3b program, 283, 306–307
Kalach (bread), 239–241
Kalzium, 324
Kanagram, 325
Kate, 313
Kbabel. See Rosetta.
KBruch, 325
KDE (K Desktop Environment)

current version, 275
desktop. See Plasma.
GNU General Public License, 275
green dragon, 275
Harmony project, 275
history of, 274–276
Konqi, 275
locking, 312–313
making immutable, 312–313
online resources, 276
QPL (Q Public License), 275
QT toolkit, 275

Kde-look.org, 285
Kdesktop. See Plasma.
KDevelop, 314–315
keepalived utility, 148
Kernel

booting from wrong one, 189
checking, 399
custom server, 147
OpenSolaris, 372
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Solaris. See Nexenta OS.
version

determining, 354
Edubuntu, 353–355
updating, 353–355

version, Edubuntu, 353–355
Keyboards

configuring
from desktop CD, 41
Kubuntu, 280, 293
LTSP, 336

typing gibberish, 221–222
Keyring devices, 130–131, 138
KHangman, 325
Kig, 325–326
Kiosk mode, 312–313
Kioslaves, 300
KiwiNZ (Ubuntu Forums denizen), 389
Kmail, 309–310
KMenu style, reverting to, 285
KmPlot, 326
Konqi, 275
Konqueror

bookmarking Web pages, 305
file manager, 299, 300–302
Google searches, 300, 305
kioslaves, 300
Kubuntu, 305
orange icon, 305
RSS feed indicator, 305
shortcuts, 300
Web browser, 305

Konsole, 313
Kontact

calendar mode, 310–311
e-mail accounts, setting up, 309–310
overview, 308
PIM (personal information manager), 308
RSS feeds, tracking, 311–312
starting, 309

Kopete, 306–308
KOrganizer, 310–311
KPackageKit installer, 288
KPDF, 314
KPPP, 314
KRandRtray, 315
KRDC, 314
Krita, 367
KRunner, 291
KSnapShot, 314
Ksplash, 292
KStars, 326–328
KSysGuard, 314
KSystemLog, 314
KTouch, 328, 410
KTurtle, 328
Kubuntu

accessibility, 293
customizing. See also Kubuntu, system

administration; Kubuntu, system
settings.

accessibility options, 293
desktop. See Plasma.
GHNS (Get Hot New Stuff), 286–287
KMenu style, reverting to, 285
ksplash, 292
locking the screen, 284
making immutable, 312–313
password, 284
splash screen, 292

description, 366–367
desktop. See Plasma.
file management

browsing files, 300
default manager. See Dolphin.
Dolphin file manager, 297–298. See also

Konqueror.
file structure changes, 299–300
finding files, 300
folder access, 283
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Kubuntu, continued
file management, continued

freedesktop.org standards, 299–300
Google searches, 300
kioslaves, 300
Konqueror file manager, 299, 300–302. See

also Dolphin.
music management, 303
shortcuts, 300
split view, 299
USB drive access, 302
Web searches, 300
Windows partition access, 302
XDG Base Directory Specification, 299–300
XDG directories, 299–300, 301

help, 316
history of, 276–277
installing. See Installing Kubuntu.
K Control Center. See Software Management,

System Settings.
Kdesktop. See Plasma.
KMenu style, reverting to, 285
managing repositories, 290–291
navigation

Application Launcher, 282–283
logging out, 284
restarting, 284
shutting down, 284

online resources, 367
overview, 274
Start menu. See KMenu.
system administration. See also Kubuntu,

customizing; Kubuntu, system
settings; Software Management.

Adept. See KPackageKit installer.
installing packages, 287–290
KPackageKit, 288
sudo, as a root account, 284

vs. Ubuntu, 30
Kubuntu, applications

3D mapping, 315
Akregator, 311–312

appointment scheduling, 310–311
automatic login, 315–316
Calc, 304
calculator, 304, 313
calendars, 310–311
command line access, 313
Draw, 304
drawing programs. See Draw program.
e-mail, 309–310
Excel equivalent, 304
Favorites list, 282
globe application, 315
Gwenview, 314
IDE (Integrated Development Environment),

314–315
image viewer, 314
Impress, 304
instant messaging, 306–308
Internet dial-up tool, 314
IRC (Internet Relay Chat), 308
K3b program, 283, 306–307
Kate, 313
KDevelop, 314–315
Kiosk mode, 312–313
Kmail, 309–310
Konqueror, 305
Konsole, 313
Kontact

calendar mode, 310–311
e-mail accounts, setting up, 309–310
overview, 308
RSS feeds, tracking, 311–312
starting, 309

Kopete, 306–308
KOrganizer, 310–311
KPDF, 314
KPPP, 314
KRandRtray, 315
KRDC, 314
Krita, 367
KSnapShot, 314
KSysGuard, 314
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KSystemLog, 314
launching, 282–283
Marble, 315
Math, 304
meetings, scheduling, 310–311
naming, 282
Numlock activation, 316
Okular, 314
OpenOffice.org, 304
PDF viewer, 314
Performance Monitor, 314
PIM (personal information manager). See

Kontact.
PowerPoint equivalent, 304
presentations. See Impress.
Quassel, 308
recently-used list, 63
remote desktop connection, 314
remote dial-up tool, 314
RSS feeds, tracking, 311–312
running at startup, 315
screen capture program, 314
Speedcrunch, 313
spreadsheets. See Calc.
System Logs Viewer, 314
text editor, 313
Web browsing

Firefox, 306
Konqueror, 305

Web feeds. See RSS feeds.
Word equivalent, 304
Word Processor, 304
Writer, 304

Kubuntu, system settings. See also Kubuntu,
customizing; Kubuntu, system
administration; Software Management,
System Settings.

accessibility options, 293
adding/removing software, 294
Akonadi configuration, 295
audio CDs, 294
date and time, 293

Desktop Search configuration, 295
digital cameras, 294
display, 293
file associations, 294
fonts, 293
input actions, 293
keyboard behavior, 293
ksplash, 292
monitors

configuring, 315
detecting, 315
making immutable, 312
power conservation, 293
resizing, 315
rotating, 315
screen orientation, 293
screen resolution, 293
splash screen, 292
standby mode, 293
systemwide changes, 312
turning off automatically, 293
wallpaper, 312

mouse behavior, 293
multimedia, 293
Nepomuk configuration, 295
network configuration, 296–297
password, 284
personal information management, 295
power conservation, 293
printer configuration, 296–297
privileges, systemwide, 298
starting/stopping services, 295
startup services, configuring, 294–295
VPNs (Virtual Private Networks), 296
wireless networks, 296

#kubuntu IRC channel, 249, 308–309, 316
Kubuntu Software tab, 290
KVM virtualization, 179–180, 234–235

“Label” setting, 54
Labeling partitions, 54
LAN (wired), can’t connect, 211
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Language selection
from alternate install CD, 48
changing, 103
from the desktop area, 59
from the desktop CD, 39, 40
during installation, 39, 40, 48
LTSP, 336

Launchpad
Answers, 28, 377–378
applications, writing and tracking, 377
archive management, 374
Bazaar, 379
Blueprint, 28, 377
bugs, reporting and tracking, 28, 237–239,

375–376. See also Malone.
code restrictions, 373
components, 28
definition, 27
description, 27–29, 372–374
distribution management, 28
encryption, 378
feature tracking, 28
Malone, 28, 375–376
online resources, 374
revision control system, 379
Rosetta, 28, 374–375
source for installation CDs, 36
Soyuz, 28, 374
specification tracking, 28
support tracking, 28
translation software, 28

Layers, image editing, 83
LCD screens, font appearance, 192
LCoC (Leadership Code of Conduct), 21–22
Legal restrictions, downloading music, 303
less command, 401. See also zless command.
/lib folder, 108
Linux

creating Ubuntu installation CDs, 38
history of Ubuntu, 3–7
Spanish version, 370–371

The Linux Documentation Project, 405

Linux Terminal Server Project (LTSP). See LTSP
(Linux Terminal Server Project).

Linux User Groups (LUGs). See LoCos (local
community teams).

Linux Virtual Server utility, 148
LinuxCommand.org, 405
Linux-VServer projects, virtualization, 179
LIRC (Linux Infrared Control)

for computer remote control, 222–223
drivers, configuring, 222–223
lirc package, 210
for MythTV remote control, 222–223
online resources, 223
restarting, 222
testing, 222–223

lirc package, 210
Listing

files, 63, 394, 398
HAL devices, 400
hardware, 400
owned files, 170
packages, 163
USB buses, 400

Live bookmarks, 71
Localization. See Translation and localization.
Location. See Geographical location.
Lock Screen option, 67
Lockdown editor, 357–358
Locking

the root account, 232
screens, 67, 106, 284, 357

LoCos (local community teams), 262
Log files

auth.log, 175
dmesg, 175
folder for, 108
installing Ubuntu Server, 149
mail.log, 175
messages, 175
syslog, 175
tail utility, 176
tools for, 176
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Ubuntu Server, 175–176
zcat command, 176
zgrep command, 176
zless command, 176

Log Out option, 67
Logging in, automatically, 199, 315–316
Logging out

Edubuntu, 356
ending current session, 67
Guest Session option, 67
Hibernate option, 68
hibernating, 68
Kubuntu, 284
Lock Screen option, 67
locking the screen, 67
Log Out option, 67
Restart option, 68
restarting the computer, 68
Shut Down option, 68
shutting down, 68
Suspend option, 67
suspending power, 67
switching users, 67
Ubuntu, 67–68

Logical Volume Manager (LVM). See LVM
(Logical Volume Manager).

Logical volumes (LVs), 155–156
Login screens, 209–210
Logo corrupted when booting, 189
Logo programming language, 328
Look & feel, customizing. See Themes and

backgrounds.
Look & Feel section, 292–293. See also Themes

and backgrounds.
Lower-power computers, running Ubuntu. See

Installing Ubuntu, alternate install CD;
U-lite; Xubuntu.

LPIA (low-power Intel architecture) support, 35
ls command, 394, 398
lsb_release -a command, 400
lshal command, 400
lshw command, 400

lspci command, 400
lsusb command, 400
LTS (Long Term Support), 3, 161
LTSP (Linux Terminal Server Project). See also

Edubuntu.
benefits of, 332–333
boot process, technical details, 331–332
definition, 330
description, 330–332
diskless clients, 330–332
dual booting, 331
installing. See Installing LTSP.
Intel Boot Agents will not boot, 360
IP address, changing, 348
IP address not received, 359
NFS server not responding, 359–360
server management

installing applications, 346–347
IP address, changing, 348
local devices, 348–349
password display, 348
printing, 350–351
removing applications, 347
sound, 349–350
SSH keys, updating, 348
update notification, 345
updating the server, 345
window manager alternatives, 351–352

SSH keys, updating, 348
thin clients, 333
troubleshooting, 358–360
VMware client crashes while booting, 360

LUGs (Linux User Groups). See LoCos (local
community teams).

LVM (Logical Volume Manager). See also RAID
(redundant array of inexpensive disks).

fault tolerance, 158
LVs (logical volumes), 155–156
partition management, 155
PEs (physical extents), 156
PVs (physical volumes), 155–156
redundancy, 158
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LVM, continued
setting up, 156–158
storage fluidity, 158
theory of, 155–156
VGs (volume groups), 155–156

LVs (logical volumes), 155–156

Mac OS X, creating Ubuntu installation CDs, 
38

Macromedia Flash. See Flash.
Magnatune store, 303
Mahjongg, 96
Mailing lists

description, 246–248
Edubuntu, 361–362
edubuntu-devel, 361–362
edubuntu-users, 361–362
online resources, 246
sounder, 248
Ubuntu community, 246–248
ubuntu-devel, 247
ubuntu-devel-announce, 247
ubuntu-devel-discuss, 247
ubuntu-users, 247

mail.log, 175
Mailman software, 246
Main areas, 59–60
Main repository, 161, 290
Making desktop areas immutable, 312–313
Malicious packages, 163
Malone, 28, 375–376
man command, 231, 397, 402–403
man intro command, 402
man -k command, 403
man man command, 402
man pages. See also Help.

accessing, 397
for commands, 231
Terminal commands, 397, 402–403

Managing repositories, Kubuntu, 290–291
Manual option, 51

Manually partitioning disks
with an alternate install CD, 52
with a desktop CD, 43–45

Maps
3D mapping, 315
globe applications, 315, 329
Marble program, 315, 329
world atlas, 329

Marble program, 315, 329
Masters of the Universe (MOTUs), 263
Math applications

factoring numbers, 325
fraction exercises, 325
function graphing, 326
geometrical construction, 325–326
graphing functions, 326
KBruch, 325
Kig, 325–326
KmPlot, 326

Math program, 304
matthew (Ubuntu Forums denizen), 389
Mauelshagen, Heinz, 155
Mavis Beacon Teaches Typing,

Ubuntu/Windows equivalent, 410
Maximizing, applications, 60
MBR (master boot record), 228–229. See also

Boot sector.
McNealy, Scott, 182
md5sum command, 196
md5sums file, 196
Media devices, folder for, 108
Media files won’t play, 205–206
/media folder, 108
Media players, Ubuntu/Windows equivalent,

408
Meetings, 78, 310–311. See also Calendars.
Memory

memtest utility, 218
problems, testing, 188
running out of, 218
usage, displaying, 399
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memtest utility, 218
Menu editor, 61–62
Menus

Applications, 61–62, 66
layout, changing, 61–62
Places, 62–63
System, 63

Meritocracy, 260
messages log, 175
Microphone doesn’t work, 207–208
Migrating from previous version, 46–47. See

also Installing Ubuntu, updates.
Mike (Ubuntu Forums denizen), 389
Minimizing, applications, 60
MIT, virtualization, 180
mkdir command, 399
mkfs commands, 221
/mnt folder, 108
Mobile phone, copying photos from, 218
Modeling, Ubuntu/Windows equivalent, 

410
Money, Ubuntu/Windows equivalent, 409
Monitors. See also Screens.

Edubuntu
blanking screens, 357
locking screens, 357
resolution, 338

Kubuntu
configuring, 315
detecting, 315
locking the screen, 284
making immutable, 312–313
power conservation, 293
resizing, 315
rotating, 315
screen orientation, 293
splash screen, 292
standby mode, 293
systemwide changes, 312
turning off automatically, 293
wallpaper, 312

resolution
Kubuntu, 293
Ubuntu, 199

subpixel hinting, 192
MOTUs (Masters of the Universe), 263
Mount options, 54, 173–174
“Mount point” setting, 54
Mount points, partitioning disks

with an alternate install CD, 54
with a desktop CD, 45

Mounting/unmounting devices
automatically, 130
CD-ROMs, 217
description, 130
digital cameras, 132
DVDs, 217
file execution, prohibiting, 173
floppy disks, 132
folder for, 108
last-access log, disabling, 174
mount options, 173–174
noatime option, 174
nodev option, 173
noexec option, 173
nosuid option, 173
special device files, prohibiting, 173
suid restrictions, 173
troubleshooting, 130
USB keyrings, 130–131
USB storage devices, 215–216

Mouse behavior, Kubuntu, 293
Movement-disabled users. See Accessibility.
Movie Player, 97
Movies. See Video.
Moving files and folders, 110, 398
MP3 format, 112, 115–116
msttcorefonts package, 190–191
Muine, Ubuntu/Windows equivalent, 408
Multimedia. See also Audio; Music; Sound; Video.

Blender, 98
codecs, 112–113, 116
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Multimedia, continued
compression. See Codecs.
Kubuntu, 293
production studio, 98
troubleshooting. See Troubleshooting,

multimedia.
Ubuntu Studio, 369–370

Multiverse repository, 161, 290
Music. See also Audio; Multimedia.

Amarok music manager, 303
Audio CD Extractor, 101
Cool Streams, 303
copyright violations, 205–206, 303
DMCA (Digital Millennium Copyright Act),

205–206
DRM (Digital Rights Management), 303
legal restrictions, 205–206, 303
Magnatune store, 303
managing, 303
online radio, 303
online stores, 303
portable music players, managing, 303
recording, 101
Shoutcast Streams, 303

mv command, 398
My Computer, Ubuntu equivalent, 62
My Documents, Ubuntu equivalent, 62
Mythbuntu, 211, 369
MythTV, 210–211, 222–223
mythtv package, 210

nano command, 401
nano text editor, 401
NAT settings, detecting, 90, 91
Nautilus. See also File Manager.

.fonts folder, opening, 192
emblems, 111
files

copying, 110
displaying, 110
moving, 110
selecting, 110

folders
. (dot) prefix, 107
annotating, 111
/boot, 108
categorizing, 111
for configuration settings, 107
copying, 110
creating, 109
current system status, 108
/dev, 108
device configuration files, 108
vs. directories, 106
/etc, 108
general software, 108
hidden, 107–108
/home, 108
/lib, 108
Linux structure, 107–108
log files, 108
/media, 108
media devices, 108
/mnt, 108
mounting devices, 108
moving, 110
/opt, 108
optional software, 108
/proc/sys, 108
/root, 108
/sbin, 108
selecting, 110
subfolders, displaying, 108–109
superuser software, 108
for system configuration files, 108
system libraries, 108
/usr, 108
/var, 108
view, switching, 109

scripting, 202–203
sidebar, 111
starting, 108
storing and organizing files, 106–109
view, switching, 109
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Nepomuk configuration, Kubuntu, 295
Nero Burning ROM, burning CDs/DVDs, 37
Netmeeting support, Ekiga, 87
Network configuration, Kubuntu, 296–297
Network interface report, 400
Network Management section, 296–297
Network menu item, 63
Network Neighborhood, Ubuntu equivalent, 63
Networks

file transfer with SSH (Secure Shell), 212
firewalls, 90, 176–177
iptables command, 176–177
SSH (Secure Shell), 212
troubleshooting. See Troubleshooting,

networking.
wired LAN can’t connect, 211

New Printer wizard, 135–136
Nexenta OS, 372
NFS root, updating, 352–353
Nibbles, 96
NICs (network interface cards), LTSP, 334–336,

336–337
No open ports policy, 171
noatime option, 174
nodev option, 173
noexec option, 173
Non-Synaptic applications, installing, 196–197.

See also Autopackages.
nosuid option, 173
Notes option, 111
Notification area, 65
Notification of available upgrades, 127, 201
Notification section, 292
NTFS filesystem, 219–220
nUbuntu, 366
NUMA, Ubuntu Server, 147
Numlock activation, 316

OCFS2 filesystem, 148
Office suite. See OpenOffice.org.
Official support, definition, 161
Ogg Theora, 113

Ogg Vorbis, 113
Okular, 314
Older computers, running Ubuntu. See

Installing Ubuntu, alternate install CD;
U-lite; Xubuntu.

Online radio, 303
Online resources. See also Help.

Answers, 377–378
archive management, 374
backup strategies, 140
Bazaar, 379
BIOS manual, 39
Blueprint, 377
bugs, reporting and tracking, 376
bulletin boards. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
codecs, 113, 116
CVE numbers, 128
development discussions. See Blogs; IRC

(Internet Relay Chat); Mailing lists;
Web forums; Wikis

DRBD (Distributed Replicated Block
Device), 181

dual booting, 344
DVDs, format restrictions, 117
Edubuntu, 361–362
feature tracking, 377
Firefox extensions, 71–72
The Fridge, 254–255
gNewSense, 372
grep tutorials, 401
Guadalinex, 370–371
installation CDs, 36, 37
IRC channels, list of, 249
KDE (K Desktop Environment), 276
Kubuntu, installing, 35
Kubuntu wiki, 316
KVM virtualizer, 180
Launchpad, 36, 374
The Linux Documentation Project, 405
LinuxCommand.org, 405
mailing lists, 246
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Online resources, continued
Malone, 376
Mythbuntu, 211
MythTV, 210
Nepomuk, 295
Nexenta OS, 372
nUbuntu, 366
Planet Ubuntu, 71, 259–260
Plasma, 285
podcasts, 114
RAID modes, 152
repositories, 193–194
revision control system, 379
Rosetta, 374–375
security vulnerabilities, 128
sed tutorials, 401
Soyuz, 374
specification tracking, 377
support requests, tracking, 378
text files, searching and editing, 401
themes, 105
Ubuntu derivatives, 30–31
Ubuntu developer blogs, 71
Ubuntu Server, security, 177
Ubuntu Server Edition, 368
Ubuntu Studio, 369–370
U-lite, 372
user account security, 172
Web forums, 250–251. See also Ubuntu

Forums.
wikis, 251–254
X configuration, 190
Xubuntu, installing, 35

Open applications, displaying, 65–66
Open source, 6–7
OpenOffice.org

creating documents
mathematical expressions builder. See Math.
presentations. See Impress.
spreadsheets. See Calc.
word processing. See Desktop publishing;

Writer.

drawing. See Draw program.
file formats, 73
Kubuntu, 304

OpenSolaris kernel distribution, 372
OpenVZ, virtualization, 179
Operating systems. See specific operating systems.

emulating. See Ubuntu, virtualization.
running within operating systems. See

Ubuntu, virtualization.
/opt folder, 108
Optional software, folder for, 108
Orange icon, 305
Orbiter, Ubuntu/Windows equivalent, 410
Orphan packages, removing, 170
OS virtualization, 179
Other permission, 173
Outlook, Ubuntu/Windows equivalent, 408
Outlook Express, Ubuntu/Windows equivalent,

408
Owner permission, 173
Ownership, changing, 399

Packages
building from source, 168
definition, 123
extragears, 285
filtering, 121, 346
finding, 125. See also Repositories.
information, displaying, 165–166
installing

with Add/Remove Applications, 68,
120–122

with Synaptic, 123–125
locations. See Repositories.
maintenance, responsibility for, 263, 266
managing. See APT (Advanced Package

Tool); MOTUs (Masters of the
Universe); Synaptic; Technical Board;
Ubuntu archive; Ubuntu Server,
package management

policies, setting, 265–266
removing. See Removing, packages.
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software channels. See Repositories.
user involvement, 270–271
of widgets, 285

The panel, 59–60
Paravirtualization, 179
Parity drives, 152
Parley, 329
Partitioning disks

alternate install CD
adding partitions, 52–53
“Bootable flag” setting, 54
bootable partitions, specifying, 54
deleting partitions, 52
filesystem, specifying, 54
“Format the partition” setting, 54
FREE SPACE line, 52
Guided—Use Entire Disk and Set Up

Encrypted LVM option, 51
Guided—Use Entire Disk and Set Up LVM

option, 51
Guided—Use Entire Disk option, 51
“Label” setting, 54
labeling partitions, 54
Manual option, 51
manually, 51
mount options, 54
“Mount point” setting, 54
mount points, 54
“Reserved blocks” setting, 54
root partition, creating, 53
settings, 54
“Typical usage” setting, 54
“Use as” setting, 54

desktop CD
adding a partition, 44
default filesystem, 44–45
definition, 41
for dual boot, 41–43
manually, 43–45
minimum number of partitions, 42
mount points, 45
for Ubuntu only, 42–43

/home partition, 149–150
installing Ubuntu Server, 149–150
Kubuntu, 280
LTSP (Linux Terminal Server Project),

337–339
LVM (Logical Volume Manager), 155
swap partitions, encrypting, 158
/tmp partition, 149
Ubuntu Server, 149–150
Ubuntu Server security, 149–150, 

173–174
/var partition, 149–150

passwd command, 401
Passwords. See also Security.

for Administration features, 63
administrative access, 284
changing, 293, 401
for directory encryption, 158–159
displaying, Edubuntu, 348
guidelines for creating, 46
recovering, 232–233
SSH file transfer, 212
storing in keyring devices, 138

PDF files
creating with OpenOffice.org, 74
viewing, 314

Pen disks. See USB storage devices, keyring
devices.

Perens, Bruce, 6
Performance

analyzing, 97, 231
desktop, enhancing, 227–228
enhancing, 227–228
File Manager, enhancing, 194
monitoring, 97, 314
system, analyzing, 231

Performance Monitor, 314
Periodic table exploration, 324
Permissions. See also Privileges.

changing, 399
files, 394, 399
LTSP (Linux Terminal Server Project), 338
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Permissions, continued
Ubuntu Server, 172–173
USB storage devices, 219

Personal accounting, Ubuntu/Windows
equivalent, 409

Personal section, 293
PEs (physical extents), 156
Pessulus lockdown editor, 357–358
Philosophical goals of Ubuntu, 18–20
Photo editors, Ubuntu/Windows equivalent,

408
Photographs

copying from mobile phone, 218
editing. See Images (graphic), editing.
managing

F-Spot Photo Manager, 97, 132
GIMP Image Editor, 132
Krita, 367

Photoshop, Ubuntu/Windows equivalent, 408
Physical drive failure, RAID, 154
Physical extents (PEs), 156
Physical storage, moving. See LVM (Logical

Volume Manager).
Physical volumes (PVs), 155–156
Physics simulator, 329
Pictures. See Drawing; Images (graphic),

editing; Photographs.
Pidgin

Buddies menu, 87
description, 84–85
instant messaging, 86–87
IRC (Internet Relay Chat), 87
setting up accounts, 85–86
Ubuntu/Windows equivalent, 409

PIM (personal information manager)
Akonadi, 295
Evolution, 74
Kontact, 308

Pipelines, 395–396, 404
Places menu, 62–63
Places option, 111
Planet Ubuntu, 71, 259–260

Planetarium, Ubuntu/Windows equivalent, 410
Planner, Ubuntu/Windows equivalent, 410
Plasma

adding items to, 285
backgrounds, 285
customizing, 285–286
GHNS (Get Hot New Stuff), 286–287
immutable desktop area, 312–313
online resources, 285
removing items from, 285
templates, sharing, 286
wallpaper, 285
widgets, 285–286

Playing
audio, 97, 113–116
audio CDs, 115–116
video, 97, 116–117

Plug-ins
Edubuntu, 358
Firefox, 71–72

Podcasts, 114
PolicyKit Authorizations section, 298
Pooling drives, RAID, 151
Portable music players, managing, 303
POSIX model, 173
Posts, Ubuntu Forums, 386–388
Power, electrical. See Electrical power.
Power Control section, 293
PowerPC support, 35
PowerPoint, 190–191, 304, 407
A Practical Guide to Linux® Commands...,

405
Preferences. See Configuring; Customizing;

Kubuntu, system settings; Software
Management, System Settings.

Preferences menu item, 63
Presentation software, Ubuntu/Windows

equivalent, 407
Previewing sound files, 194
Printer configuration, Kubuntu, 296–297
Printer configuration application, 133–134
Printer Configuration section, 296–297
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Printers
adding, 134
configuring. See Configuring, printers.
drivers, specifying, 135–136
model, specifying, 135–136
New Printer wizard, 135–136
Printer configuration application, 133–134
printing a test page, 136
remote printing, 136–137

Printing
in Edubuntu, 350–351
system information, 399
version information, 400
working directory, 397

Privileges, systemwide in Kubuntu, 298. See also
Permissions.

Problems
reporting, 237–239. See also Launchpad;

Malone.
solving. See Troubleshooting.

Process information, displaying, 399
Process management, Edubuntu, 356
Processes, viewing, 400
/proc/sys folder, 108
Production studio, 98
Profile pictures, Ubuntu Forums, 390
Programming, user involvement, 270–271
Programs

adding. See Installing.
application. See Applications.
failure to close, 201
operating systems. See specific operating

systems.
emulating. See Ubuntu, virtualization.
running within operating systems. See

Ubuntu, virtualization.
packaged for installation. See Packages.

Project, Ubuntu/Windows equivalent, 410
Project management, Ubuntu/Windows

equivalent, 410
PROMPT option, 343
ps command, 400

Publisher, Ubuntu/Windows equivalent, 409
pulseaudio, 207
PVs (physical volumes), 155–156
pwd command, 397
pybackpack, 140

Qemu virtualization, 179, 234–236
QPL (Q Public License), 275
QT toolkit, 275
Quality assurance, user involvement, 270
Quassel, 308
Question mark (?), wildcard character, 403
Quickbooks, Ubuntu/Windows equivalent, 409
Quicken, Ubuntu/Windows equivalent, 409
QuickTime, restrictions, 112

Radio, online, 303
RAID (redundant array of inexpensive disks)

array failure, 154
array management. See LVM (Logical Volume

Manager).
backing up data, 153
choosing, 152
data replication, 151
degraded mode, 154
description, 150–151
fault tolerance, 150–151
levels, 151
modes, 152
parity drives, 152
physical drive failure, 154
pooling drives, 151
RAID 0, 151
RAID 1, 151
RAID 5, 151
setting up, 152–154
space requirements, 151
spare devices, 153
striped set, 151

RAID 0, 151
RAID 1, 151
RAID 5, 151
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RAID array failure, 154
rar, 140
Raymond, Eric S., 6
RealMedia, restrictions, 112
Recent Documents menu item, 63
Recently Used tab, 283
Recently-used documents, listing, 63
Recognized derivations, 368–370
Recording

music, 101
sound, 97

Recovery mode option, 187
Red Hat Cluster Suite, 148
Redundancy, LVM, 158
Releases. See also specific releases.

first, 2
LTS (long-term support), 23
new, updating to. See Installing Ubuntu,

updates.
scheduling, 22–23
support duration, 23, 128

Reminders. See Calendars.
Remote

desktop connection, 314
dial-up tool, 314
file access, 212–213
printing, 136–137

Remote control
computer, 222–223
doesn’t work, 222–223
installing, 222–223
MythTV, 210, 222–223
online resources, 223
Totem media player, 117
troubleshooting, 222–223

Removing. See also Deleting.
applications, Edubuntu, 347
packages

with apt-get, 166
orphans, 170
with Synaptic, 125

programs. See Adding/removing programs.

user accounts, 172, 401–402
user groups, 402

Rendering, 98
Repetitive strain injury (RSI), 241
Reported bugs, checking for. See Malone.
Reporting bugs. See Malone.
Repositories. See also Ubuntu archive.

additional, enabling, 193–194, 226–227
backports, 161–162, 167
definition, 123
Kubuntu, 290–291
local copy of, 194
main, 161, 290
missing applications, 193–194, 226–227
multiverse, 161, 290
online resources

enabling additional, 193
local copies, 194

restricted
definition, 161
gNewSense, 371
Kubuntu, 290
Ubuntu, 161

third-party, 290–291
Ubuntu archive

backports, 161–162, 167
main, 161
multiverse, 161
restricted, 161
universe, 161–162

universe, 161–162, 290
Rescue mode, 188
“Reserved blocks” setting, 54
Resizing, monitors, 315
Resolution, screen

Edubuntu, 338
Kubuntu, 293
Ubuntu, 199

Restart option, 68
Restarting

the computer, 68
Kubuntu, 284
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Restoring
boot sectors, 188
deleted items, 195
passwords, 232–233
root accounts, 232

Restricted repositories, 161, 290, 371
Restrictions

codecs, 112–113
drivers, 190
MP3 format, 112
multimedia formats, 112–113, 205
packages, 161
QuickTime, 112
RealMedia, 112
repositories, 161, 290, 371
Windows Media Format, 112

Revision control system, 379
Rhythmbox, 113–115, 408
Riddell, Jonathan, 276
Ripping audio CDs, 115–116
rm command, 398
Root account

disabling, 232
enabling, Ubuntu Server, 159–160
locking, 232
preventing automatic login, 199
restoring, 232
sudo instead of, Kubuntu, 24
Ubuntu Server, enabling, 159–160, 172

/root folder, 108
Root partition, creating, 53
Root privileges, temporary, 232
Rosetta, 28, 374–375
Rotating, monitors, 315
RSI (repetitive strain injury), 241
RSS feed indicator, 305
RSS feeds, tracking, 311–312
rsync process, 140, 194

SABDFL (self-appointed benevolent dictator
for life), 261, 266–267

Savage, Pete, 355

Saving, Writer documents, 73
sbackup, 140
/sbin folder, 108
Scalable Vector Graphics (SVG), 98–99
Scheduling events, 223–226. See also Calendars;

Cron; Crontab.
Schools, Ubuntu for. See Edubuntu.
Schwartz, Jonathan, 182
scp command, 226
Screens. See also Monitors.

capturing, 314
orientation, 293
resolution

changing, 199
Edubuntu, 338
Kubuntu, 293
LTSP (Linux Terminal Server Project), 338
Ubuntu, 199

Screensavers, configuring, 105
Scribus, 409
Scripting file managers, 202–203
Search Bar, 283
Search for Files menu item, 63
Search tools. See also Finding.

Beagle, 99
desktop search box, 70
Firefox, 70
Google, Kubuntu, 300, 305
indexing searchable material, 99

Searching
for files, 63, 176, 400
in Firefox, 70
for packages, 165–166

Secure Shell (SSH), 212
Security. See also Passwords.

locking the screen, 106
patches, applying, 167
of third-party packages, 163
Ubuntu Server. See Ubuntu Server, security.
vulnerability identifier, 127–128

Security-related updates, 126, 127–128
sed command, 401
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sed text editor, 401
sed tutorials, 401
Selecting files and folders, 102–103, 110
Self-appointed benevolent dictator for life

(SABDFL), 261, 266–267
Semicolon (;), running multiple commands,

226
Sending messages. See also E-mail.

broadcasting to Edubuntu users, 357
instant messaging, 86–87, 306–308, 409

Server configuration, LTSP, 334–336
Server management, Edubuntu. See also LTSP

(Linux Terminal Server Project).
installing applications, 346–347
IP address, changing, 348
local devices, 348–349
password display, 348
printing, 350–351
removing applications, 347
sound, 349–350
SSH keys, updating, 348
update notification, 345
updating the server, 345
window manager alternatives, 351–352

Servers
connecting to, 63
vs. desktop machines, 23. See also Ubuntu

Server.
e-mail, 76–77
installing from alternate install CD, 48
setup, LTSP, 338–339

Service and support. See Technical support.
Service Manager section, 294–295
Settings, partitioning disks, 54
Shortcuts

to applications, 64
icons, 64
kioslaves, 300
Konqueror, 300
sudo command, 232

Shoutcast Streams, 303
Shut Down option, 68

Shutting down, 67–68, 284. See also Logging
out.

Shuttleworth, Mark. See also History of
Ubuntu.

Community Council member, 265
company founded by. See Canonical Ltd.
HBD (Here Be Dragons), 8
on Launchpad code restrictions, 373
profile, 7–8
SABDFL (self-appointed benevolent dictator

for life), 261, 266–267
space travel, 8
Thawte, 8
TSF (The Shuttleworth Foundation), 8
Verisign, 8
the Warthogs, 9–10

Sidebar, Nautilus, 111
Signatures, Ubuntu Forums, 390
Simon Says, 329
SIP support, Ekiga, 87–88
Skype, Ubuntu/Windows equivalent, 409
Slackware, 14
SLS (Softlanding Linux System), 14
Smart updates, 128
Sobell, Mark G., 405
Software channels. See Repositories.
Software Management. See also Kubuntu,

customizing; Kubuntu, system
administration.

adding/removing programs, 288–290
Appearance section, 292
authentication, 290
Authentication tab, 290
Desktop section, 292
KPackageKit, 288
Kubuntu Software tab, 290
Look & Feel section, 292
main repository, 290
managing repositories, 290–291
multiverse repository, 290
Notification section, 292
password, changing, 293
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Personal section, 293
restricted repository, 290
Statistics tab, 290
third-party repositories, 290–291
Third-Party Software tab, 290
universe repository, 290
update notification, 291
Updates tab, 290
upgrading Kubuntu, 291
Window Behavior section, 292

Software Management, System Settings. See also
Kubuntu, system settings.

Add or Remove Software section, 294
Advanced tab, 292, 294
Advanced User Settings section, 294–295
Appearance section, 292
Computer Administration section, 293
Desktop section, 292
Display section, 293
General Tab, 292
Look & Feel section, 292–293
Notifications section, 292
overview, 291–292
Personal section, 293
Power Control section, 293
Service Manager section, 294–295
System section

Network Management section, 296–297
PolicyKit Authorizations section, 298
Printer Configuration section, 296–297

Window Behavior section, 292
Software stores. See Repositories.
Software upgrades

checking for, 201
failure, 199–200
installing. See Installing Ubuntu, updates.
new version of Ubuntu, 201

Solaris kernel. See Nexenta OS.
Sound. See Audio; Multimedia; Music.
Sound cards, mixer settings, 65
Sound Juicer. See Audio CD Extractor.
Sound Recorder, 97

Sound server, 207
Sounder mailing list, 248
Source code, free access to, 4–5
Soyuz, 28, 374
Space exploration, 326–328
Spanish language distribution, 370–371
Specification tracking, 28
Speedcrunch, 313
Spillner, Josef, 286
Spin-offs from Ubuntu, 30–31
Splash screens

customizing, 292
disabling, 189
installing, 209–210
Kubuntu, 292

Spools, 149–150
Spreadsheets, Ubuntu/Windows equivalent, 407
Sprints, 255–257
SSH (Secure Shell), 212
ssh client, 149
SSH keys, updating in Edubuntu, 348
Stallman, Richard M.

chief gnuisance, 371
free software, 3–5
gNewSense, 371
GNU project, 5
history of Ubuntu, 3–7
Linux, 5
open source, 5–7

Standby mode, monitors, 293
Starry Night, Ubuntu/Windows equivalent, 410
Stars database, 326–327
Starting programs, Edubuntu, 357
Starting/stopping services, Kubuntu, 295
Startup services, configuring in Kubuntu,

294–295
Statistics tab, 290
Stellarium, Ubuntu/Windows equivalent, 410
Step, 329
Stick disks. See USB storage devices, keyring

devices.
Stock kernel option, 187
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Storage, physically moving. See LVM (Logical
Volume Manager).

Storage fluidity, LVM, 158
Storing and organizing, files and folders,

106–109
Striped RAID sets, 151
Structures and processes, responsibility for, 265
Student Control Panel. See Thin Client

Manager.
Subfolders, displaying, 108–109
Subforums, 386
Subpixel hinting, 192
Subprojects of Ubuntu, 30–31
sudo command

instead of a root account, 172, 284
shortcut, 232
superuser privileges, 172, 396
temporary root privileges, 232

Sudoers database, 172–173
Sudoku, 97
suid restrictions, 173
Summits, 255–257
Sun Microsystems, virtualization, 180
Superusers

reserving space for, 54
running Terminal commands, 396
software, folder for, 108

Support. See Technical support.
Suspend option, 67
Suspending electrical power, 67
SVG (Scalable Vector Graphics), 98–99
Swap partitions, encrypting, 158
Switching

between applications, 66
between Kubuntu and Ubuntu, 278
users, 67

Synaptic
can’t find an application. See Autopackages.
checking for updates, 128
description, 123
finding, 123
finding packages, 125

installing packages, 123–125
name origin, 123
removing packages, 125
starting, 123
Type-ahead feature, 125–126

Syslinux home page, 344
System administration

customizing your system. See Customizing.
Kubuntu. See Kubuntu, customizing;

Kubuntu, system administration;
Software Management.

troubleshooting. See Troubleshooting, system
administration.

System administrator account, Ubuntu Server,
172

System configuration files, folder for, 108
System information

command-line interface to. See Terminal
commands, system information.

printing, 399
System libraries, folders for, 108
System log files, Ubuntu Server, 175–176
System Logs Viewer, 314
System menu, 63
System Monitor, 97
System problems, troubleshooting. See

Troubleshooting, system problems.
System resource limits, Ubuntu Server, 

174–175
System section, 296–298
System settings, Kubuntu. See Kubuntu, system

settings; Software Management, System
Settings.

System status, folder for, 108
System updates, with apt-get, 166–167
Systemwide changes, monitors, 312

Tabbed Web browsing, 70
Tagging bookmarks, 70
tail utility, 176
Taskbar, 60, 65–66
Team councils, 261–262
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Teams
creating and dissolving, 264
LoCos (local community teams), 262
meritocracy, 260
MOTUs (Masters of the Universe), 263
overview, 261–262
team councils, 261–262

Technical Board, 265–266
Technical direction, setting, 265
Technical goals of Ubuntu, 22–24
Technical support. See also Bugs, reporting and

tracking; Help; Online resources;
Troubleshooting; Ubuntu community,
communication venues

accessing, 63
Answers, 377–378
Canonical Ltd., 26–27
cycles, Ubuntu archive, 161
LTS (Long Term Support), 3
tracking, 28
user involvement, 268–269

Telephone, over the Internet. See Ekiga.
Templates for new images, image editing, 79–81
Terminal

description, 138–139
finding, 96
starting, 393–394
window, illustration, 394
xterm alternative to, 227

Terminal commands
@ (at sign), in command-line username,

393–394
$ (dollar sign), UNIX shell symbol, 163,

393–394
- (hyphen), dash in commands, 225, 395
? (question mark), wildcard character, 403
| (vertical bar), pipe symbol, 139, 395, 404
[ ] (brackets), wildcard characters, 403
[! ] (brackets, exclamation point), wildcard

characters, 403
~ (tilde), home directory indicator, 164,

393–394, 398

documentation. See Man pages.
executing multiple, 404
help, 397, 402–403
man pages, accessing, 397
passing output. See Pipelines.
pipelines, 139, 395–396, 404
A Practical Guide to Linux® Commands..., 405
running as a superuser, 396
running sequentially, 404
stringing together. See Pipelines.
sudo, 396
wildcards, 403

Terminal commands, files and folders
cat, 395, 401
cd, 395, 397
changing directories, 395
chmod, 399
chown, 399
copying files, 398
cp, 398
creating folders, 399
deleting files, 398
files

contents, viewing, 395
copying, 398
deleting, 398
listing, 398
moving, 398
ownership, changing, 399
permissions, changing, 399

folders
changing, 397
creating, 399
current, identifying, 397

grep, 400
less, 401
listing files, 394, 398
ls, 394, 398
mkdir, 399
moving files, 398
mv, 398
nano, 401
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Terminal commands, files and folders, continued
ownership, changing, 399
permissions, changing, 399
printing working directory, 397
pwd, 397
rm, 398
sed, 401
text files, searching and editing, 400–401

Terminal commands, system information
df, 399
disk space usage, displaying, 399
free, 399
HAL devices, listing, 400
hardware, listing, 400
ifconfig, 400
iwconfig, 400
kernel, checking, 399
lsb_release -a, 400
lsb_release -a command, 400
lshal, 400
lshw, 400
lspci, 400
lsusb, 400
memory usage, displaying, 399
network interface report, 400
printing

system information, 399
version information, 400

process information, displaying, 399
processes, viewing, 400
ps, 400
top, 399
uname -a, 399
USB buses, listing, 400
version information, printing, 400
wireless network information, displaying,

400
Terminal commands, users and groups

addgroup, 402
adduser, 172, 233
delgroup, 402
deluser, 402

groups, adding/removing, 402
passwd, 401
passwords, changing, 401
user accounts, adding/removing, 401–402
users logged on, displaying, 402
who, 402

Testing, LIRC (Linux Infrared Control),
222–223

Text chat, Ekiga, 95
Text Chat icon, 95
Text Editor, 95
Text editors

Kate, 313
Kubuntu, 313
nano, 401
sed (Stream EDitor), 401
Text Editor, 395

Text files, searching and editing, 400–401
Text images, image editing, 81–84
Thawte, 8
The Shuttleworth Foundation (TSF), 8
Themes and backgrounds

customizing, 104–105, 208–210
finding, 209–210
icon themes, 209–210
installing, 105, 209–210
Kubuntu. See Plasma.
login screens, 209–210
online resources, 105
online sources for, 209
splash screens, 209–210, 292
window borders, 209–210

Thin Client Manager, 355–356
Thin clients, 333
Third-party packages, security, 163
Third-party repositories, 290–291
Third-Party Software tab, 290
Threads, Ubuntu Forums, 386–388
3D mapping, 315
3D modeling, 98, 410
Thunderbird, Ubuntu/Windows equivalent, 

408
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Tilde (~), home directory indicator, 164,
393–394, 398

Time and date. See Clock.
Time zone, setting, 50, 279
TIMEOUT option, 343
/tmp partition, 149
top command, 198–199, 231, 399
Torvalds, Linus, 5
Totem media player, 116–117
Totem Movie Player, Ubuntu/Windows

equivalent, 408
Touch typing tutor, 328
Tracking bugs. See Bugs, reporting and tracking;

Launchpad; Malone.
Translation and localization

software for. See Rosetta.
user involvement, 270

Trash, 66
Tree option, 111
Tribute weeks, Ubuntu Forums, 391
Troubleshooting. See also Technical support.

applications
compiling, 197–198
e-mail address, configuring, 204
e-mail doesn’t work, 204–205
Evolution, e-mail doesn’t work, 204–205
File Manager, scripting, 202–203
Firefox, Flash is missing, 203
Java not installed, 203
Nautilus, scripting, 202–203
non-Synaptic, installing, 196–197
not in repositories, 193–194, 226–227
programs won’t close, 201
replacing with Autopackages, 196–197
required tools, verifying, 198
upgrade notification, disabling, 201
windows won’t close, 201

BIOS configuration problems, 39
DVDs

encryption, 117
mounting, 217
not working, 217

playback is jittery, 206
support, enabling, 210
won’t eject, 217
won’t play, 206

e-mail, unable to connect to server, 77
finger pain, 241
home directory lockout, 159
Intel Boot Agents will not boot, 360
LTSP (Linux Terminal Server Project), 360
networking

802.1x authentication, 213–215
device support, determining, 213–215
file transfer, 212
remote graphical applications, 212–213
SSH (Secure Shell), 212
Web site not loading, 211–212
wired LAN can’t connect, 211
wireless card drivers, enabling, 214–215
wireless card not working, 213–215
WPA support, 213–215

problem reporting, 237–239. See also
Launchpad; Malone.

RAID array failure, 154
RSI (repetitive strain injury), 241
virtualization, 234–236
VMware client crashes during boot, 360

Troubleshooting, hardware
Bluetooth, copying photos from mobile

phone, 218
Bluetooth support, 218
CD-ROMs, 217
copying photos from mobile phone, 218
device doesn’t work, 217–218
device drivers, finding, 217–218
device filesystem, determining, 219–220
device support, determining, 223
disk storage. See also USB storage devices.

fixing, 230
formatting, 220–221
fsck program, 230
mkfs commands, 221
recovering from power failure, 229–230
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Troubleshooting, hardware, continued
DVDs, 217
filesystems, 219–220
keyboard types gibberish, 221–222
LIRC (Linux Infrared Control)

for computer remote control, 222–223
drivers, configuring, 222–223
lirc package, 210
for MythTV remote control, 222–223
restarting, 222
testing, 222–223

memory, 218
mkfs commands, 221
mobile phone, copying photos from, 218
remote control for

computer, 222–223
MythTV, 210, 222–223

unmounting a device, 130
USB storage devices. See also Disk storage.

files copied to/from are missing, 215–216
filesystem, determining, 219–220
mounting, 215–216
not recognized, 215–216
permissions, changing, 219
reads but won’t write, 218–219

Troubleshooting, multimedia
backgrounds, changing, 208–210
DMA (direct memory access mode),

enabling, 206
DMCA (Digital Millennium Copyright Act),

205–206
DVDs

playback is jittery, 206
support, enabling, 210
won’t play, 206

lirc package, 210
media file won’t play, 205–206
microphone doesn’t work, 207–208
Mythbuntu, 211
MythTV, installing, 210–211
remote control, MythTV, 210, 222–223
restricted formats, 112–113, 205

sound distortion, 208
sound doesn’t play, 205–207
sound server conflict, 207
themes and backgrounds, changing, 

208–210
xmltv package, 210

Troubleshooting, system administration
adduser command, 233
bug reports, filing and tracking, 237–239
command options, help for. See man pages.
copying files between computers, 63, 226
desktop, speeding up, 227–228
Desktop Effects, disabling, 227–228
desktop performance enhancement, 

227–228
disk space, reducing, 230–231
disk storage, recovering from power failure,

229–230
fixing hard disks, 230
fsck program, 230
help for commands. See man pages.
man command, 231
man pages for commands, 231
password recovery, 232–233
performance analysis, 231
performance enhancement, 227–228
root account

disabling, 232
locking, 232
preventing automatic login, 199
restoring, 232

root privileges, temporary, 232
scheduling events, 223–226. See also Cron;

Crontab.
shortcut for sudo command, 232
sudo command, 232
Synaptic can’t find an application, 227. See

also Autopackages.
temporary root privileges, 232
top command, 231
Ubuntu on older computers, 227–228,

230–231. See also Xubuntu.
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Ubuntu won’t start after Windows reinstall,
228–229

users, adding, 233
Windows partition access, 233

Troubleshooting, system problems
automatic login, 199
Autopackages, running, 196–197
boot failure, 187–188
boot logo appears corrupted, 189
boot sector, 187–188
bootloader, 187–188
compiling applications, 197–198
Ctrl-Alt-Backspace restart, 199
debmirror, 194
desktop

adding TrueType fonts, 191–192
hung, 198–199
installing a new environment, 193

disk space, freeing up, 200
Disk Usage Analyzer, 200
File Manager

displaying hidden files and folders,
194–195

freeing disk space, 200
restoring deleted items, 195
running slow, 194
speeding up, 194
viewing freed disk space, 200

fonts
on LCD screen, 192
PowerPoint, 190–191
subpixel hinting, 192
TrueType, installing, 191–192
Windows applications, 190–191
Word, 190–191

graphical interface fails to start, 190
.iso files, testing, 196
login automatically, 199
memory problems, 188
non-Synaptic applications, installing,

196–197. See also Autopackages.
PowerPoint fonts look wrong, 190–191

recovery mode option, 187
repositories

additional, enabling, 193–194, 226–227
local copy of, 194

rescue mode, 188
restricted drivers, 190
rsync process, 194
screen resolution, changing, 199
software upgrade

checking for, 201
failure, 199–200
new version of Ubuntu, 201

splash screen, disabling, 189
stock kernel option, 187
Ubuntu boots into a text interface, 190
Ubuntu keeps restarting, 188–189
Ubuntu logo corrupted, 189
Ubuntu won’t start, 187–188
Windows fonts look wrong, 190–191
Word fonts look wrong, 190–191
wrong kernel, 189
X server, restarting, 199

Troup, James, 265
Troy, Ryan, 382–383
TrueType fonts, adding, 191–192
TSF (The Shuttleworth Foundation), 8
TurboCASH, Ubuntu/Windows equivalent, 409
Tutu, Desmond, 10–11
Tux Paint, 329–330
Tux Typing, Ubuntu/Windows equivalent, 410
Type-ahead feature, 125–126
“Typical usage” setting, 54
Typing tutor, Ubuntu/Windows equivalent, 410

Ubiquity installer program, 278–281
Ubucons, 258
Ubunteros, 267–268
Ubuntites. See Ubunteros.
Ubuntu. See also Derived distributions.

booting into a text interface, 190
bread recipe, 239–241
CoC (Code of Conduct), 20–22
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Ubuntu, continued
derivatives. See Derived distributions.
developer blogs, 71
for educational environments. See Edubuntu.
financial support for. See Canonical Ltd.;

Ubuntu Foundation.
goals. See Goals of, Ubuntu.
history of. See History of Ubuntu.
for KDE (K Desktop Environment). See

Kubuntu.
keeps restarting, 188–189
LCoC (Leadership Code of Conduct), 21–22
logo corrupted, 189
for multimedia production. See Ubuntu Studio.
on older computers, 227–228, 230–231. See

also U-lite; Xubuntu.
repeatedly restarting, 188–189
spin-offs, 30–31
subprojects, 30–31
technical goals, 22–24
for use in schools. See Edubuntu.
Windows-equivalent programs. See Windows

programs, Ubuntu equivalents.
won’t start, 187–188, 228–229
won’t start after Windows reinstall, 228–229
word origin, 10–11
for Xfce window management system. See

Xubuntu.
Ubuntu archive. See also Ubuntu Server,

package management.
APT (Advanced Package Tool), 161–162
apt-cache utility, 164–167
apt-get utility, 164–167. See also aptitude

utility.
aptitude utility, 169–170. See also apt-get

utility.
backports repository, 161–162, 167
binary uploads, 168
installing packages, with apt-get, 166
LTS (Long Term Support), 161
main repository, 161
multiverse repository, 161

official support, 161
removing packages

with apt-get, 166
orphans, 170

restricted repository, 161
structure of, 160–161
support cycles, 161
system updates, with apt-get, 166–167
universe repository, 161–162

Ubuntu community. See also Ubuntu
Foundation, documentation.

activists. See Ubunteros.
CoC (Code of Conduct), 20–22
communication venues

announcements, 247
bulletin board. See The Fridge.
conferences, 257–259
developer contacts, 251
developer sprints, 255–257
developer summits, 255–257
development discussions. See IRC

(Internet Relay Chat); Mailing lists;
Wikis.

The Fridge, 254–255
general chat. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
IRC (Internet Relay Chat), 248–249
mailing lists, 246–248
overview, 245
Planet Ubuntu blogs, 71, 259–260
sprints, 255–257
summits, 255–257
support-oriented. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
Ubucons, 258
Ubuntu Live conferences, 258–259
user conferences, 257–259
Web forums, 250–251. See also Ubuntu

Forums.
wikis, 251–254

description, 17–18
history of, 17–18
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LCoC (Leadership Code of Conduct), 21–22
overview, 244–245
teams

creating and dissolving, 264
LoCos (local community teams), 262
meritocracy, 260
MOTUs (Masters of the Universe), 263
overview, 261–262
team councils, 261–262

user involvement levels
advocacy, 268
artwork, 269–270
documentation, 269
ideas and feedback, 269
packaging, 270–271
programming, 270–271
quality assurance and bugs, 270
support, 268–269
translation and localization, 270

Ubuntu community, governance system. See
also Canonical Ltd.; Teams; Ubuntu
Foundation.

code revisions, approving, 264
Community Council, 263–265
dispute arbitration, 264
feature goals, maintaining, 266
goals, 261
package maintenance, 263, 266
package policy, setting, 265–266
SABDFL (self-appointed benevolent dictator

for life), 261, 266–267
structures and processes, 265
Technical Board, 17–18, 265–266
technical direction, setting, 265
Ubunteros, 267–268
Ubuntites. See Ubunteros.
Ubuntu members

activists. See Ubunteros.
approving, 264
membership levels, 267–268
official membership, 267
rights and privileges, 267–268

Ubuntu Forums. See also Web forums.
asking questions, 386, 388–389
avatars, 390
coffee references, 390
Forums Code of Conduct, 391
getting help for, 386
history of, 382–383
key people, 389–390
messages. See Posts.
organization of, 388–389
overview, 382
participating in, 383–388
posts, 386–388
profile pictures, 390
setting up an account, 383–386
signatures, 390
staff, listing, 389–390
subforums, 386
threads, 386–388
topics. See Threads.
tribute weeks, 391
user rank image, 390
usernames, 383, 385

Ubuntu Foundation
CoC (Code of Conduct), 20–22
description, 29
documentation, 18–24
geographical location, 29
philosophical goals, 18–20

Ubuntu Help Center, 63
#ubuntu IRC channel, 249
Ubuntu Live conferences, 258–259
Ubuntu members

approving, 264
membership levels, 267–268
official membership, 267
rights and privileges, 267–268

Ubuntu Server
cloud computing, 181–182
contact information, 177
custom server kernel, 147
description, 146–148
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Ubuntu Server, continued
disk replication, 180–181
DRBD (Distributed Replicated Block

Device), 181
ecryptfs, 158
encryption, 158–159
GFS (Global File System) support, 148
home directory, encrypting, 158–159
installing. See Installing Ubuntu Server.
installing software on, 158–159
ipvsadm utility support, 148
keepalived utility support, 148
Linux Virtual Server utility support, 148
log files, 175–176
NUMA support, 147
OCFS2 filesystem support, 148
online resources, 177
partitioning, 149–150
passwords, for directory encryption, 

158–159
Red Hat Cluster Suite support, 148
security. See also Security.

adduser command, 172, 233
administrator account, 172
deluser command, 172
filesystems, 173
firewall tables, 176–177
group permission, 173
home directory encryption, 172
iptables command, 176–177
log files, 149–150
mount options, 173–174
no open ports policy, 171
noatime option, 174
nodev option, 173
noexec option, 173
nosuid option, 173
online resources, 177
other permission, 173
overview, 171
owner permission, 173

partitions, 149–150, 173–174
permission types, 173
permissions, specifying, 172
POSIX model, 173
root account, enabling, 172
spools, 149–150
sudo command, 172
sudoers database, 172–173
system log files, 175–176
system resource limits, 174–175
user account administration, 171–173
visudo command, 172–173

swap partitions, encrypting, 158
virtualization

Bochs, 179
common hardware emulators, 179
containerization, 179
definition, 178
full virtualization, 179
hardware emulation, 179
hypervisor, 179
IBM, 178–180
KVM, 179–180, 234–235
Linux-VServer projects, 179
MIT, 180
OpenVZ, 179
OS virtualization, 179
paravirtualization, 179
preferred solution, 179–180
Qemu, 179, 234–236
Sun Microsystems, 180
support for, determining, 235
troubleshooting, 234–236
types of, 179
VirtualBox, 180, 234–236
VMware, 178–180
Xen, 179–180
XVM, 180
xVM, 180
zoning, 179
z/VM, 179
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Ubuntu Server, package management. See also
APT (Advanced Package Tool); Ubuntu
archive.

apt-cache utility, 164–167
apt-get utility, 164–167. See also aptitude

utility.
aptitude utility, 169–170. See also apt-get

utility.
building packages from source, 168
command-line tools, 162–163
Debian package manager, 162–163
default packages, 147
distribution upgrades, 167–168
downloading packages, 164–166
dpkg utility, 162–163
file owner, finding, 170
file provider, finding, 170–171
installing packages

with apt-get, 166
manually, 163–164

listing owned files, 170
listing packages, 163
malicious packages, 163
package information, displaying, 165–166
removing packages

with apt-get, 166
orphans, 170

searching for packages, 165–166
security

patches, applying, 167
of third-party packages, 163

system updates, with apt-get, 166–167
Ubuntu Server Edition, 368
Ubuntu Studio, 369–370
#ubuntu+1 IRC channel, 249
Ubuntu-announce mailing list, 247
#ubuntu-devel IRC channel, 249
ubuntu-devel mailing list, 247
ubuntu-devel-announce mailing list, 247
ubuntu-devel-discuss mailing list, 247
ubuntu-geek (Ubuntu Forums denizen), 389

#ubuntu-offtopic IRC channel, 249
ubuntu-users mailing list, 247
Ukrainian egg bread, 239–241
U-lite, 372
uname -a command, 399
Uninstalling. See Removing.
Universe repository, 161–162, 290
Unmounting a device. See

Mounting/unmounting devices.
Updates tab, 290
Updating the server, Edubuntu, 345
Updating your computer. See Installing

Ubuntu, updates.
Upgrade notification, 201, 291, 345
Upgrading Kubuntu, 291
Usability, 66
USB storage devices. See also Disk storage.

accessing, 302
buses, listing, 400
copying files to the hard disk, 131
files copied to/from are missing, 215–216
filesystem, determining, 219–220
installing Ubuntu from, 55
keyring devices, 130–131, 138
mounting, 215–216
mounting/unmounting, 130–131
not recognized, 215–216
permissions, changing, 219
reads but won’t write, 218–219
USB1 vs. USB2, 131

USB1 vs. USB2, 131
“Use as” setting, 54
User accounts

adding, 172, 233, 401–402
adduser command, 172, 233
administration, Ubuntu Server, 171–173
configuring

from alternate install CD, 54
from desktop CD, 45–46
LTSP (Linux Terminal Server Project), 

338
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User accounts, continued
deleting, 172, 401–402
deluser command, 172, 402
groups. See User groups.
hostname, specifying, 45–46, 50
passwords, selecting, 46, 54
Ubuntu Forums, 383–386
usernames, for new user accounts, 46, 54

User community. See Ubuntu community.
User conferences, 257–259
User groups

addgroup, 402
adding/removing, 402
delgroup, 402
Edubuntu, 358
filtering, 358

User involvement levels
advocacy, 268
artwork, 269–270
documentation, 269
ideas and feedback, 269
packaging, 270–271
programming, 270–271
quality assurance and bugs, 270
support, 268–269
translation and localization, 270

Usernames
in command lines, 393–394
Kubuntu, configuring, 281
for new user accounts, 46, 54
Ubuntu Forums, 383, 385

Users
adding, 233
logged on, displaying, 402
logging out of Edubuntu, 356
rank image, Ubuntu Forums, 390

/usr folder, 108
UTC (Coordinated Universal Time), 

337–338

/var folder, 108
/var partition, 149

Vector drawing, Ubuntu/Windows equivalent,
410

Vendor lock-in, 74
Verisign, 8
Version, choosing for installation, 34–35
Version control tool, 27
Version information, printing, 400
Vertical bar (|), pipe symbol, 139, 395, 404
VGs (volume groups), 155–156
Video. See also Multimedia.

DVD encryption, 117
Ekiga, 90, 92
Movie Player, 97
playing, 97, 116–117
Totem media player, 116–117
watching, 116–117

View Mode icon, Ekiga, 95
View mode in Ekiga, selecting, 95
View Webcam icon, Ekiga, 95
Virtual company, 11–12
Virtual computer. See Dual boot; Ubuntu

Server, virtualization.
Virtual desktops, 66
Virtual Private Networks (VPNs), Kubuntu, 296
VirtualBox, virtualization, 180, 234–236
Virtualization. See Ubuntu Server, 

virtualization.
Visio, Ubuntu/Windows equivalent, 410
Visual themes. See Themes and backgrounds.
Visually-disabled users. See Accessibility.
visudo command, 172–173
VMware

client crashes while booting, 360
Ubuntu Server virtualization, 178–179
virtualization, 178–180

VOIP (Voice Over IP), Ubuntu/Windows
equivalent, 409. See also Ekiga.

Volkerding, Patrick, 14
Volume control, 65
Volume groups (VGs), 155–156
Voyager III, Ubuntu/Windows equivalent, 410
VPNs (Virtual Private Networks), Kubuntu, 296
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Wallpaper, 312. See also Themes and
backgrounds.

The Warthogs, 9–10
Warty Warthog, 2
Wastebasket (trash), 66
Watching video. See Playing, video.
Weather, monitoring, 239
Web browsers. See also Firefox; Konqueror.

Firefox, 306
Galeon, 227
Konqueror, 305
lightweight alternative, 227
Ubuntu/Windows equivalent, 408

Web camera configuration, Ekiga, 93
Web editor, 99–101
Web feeds. See RSS feeds.
Web forums, 250–251, 362. See also Ubuntu

Forums.
Web searches, Kubuntu, 300
Web sites

about Edubuntu, 361
bookmarking, 305
browsing. See Firefox; Konqueror.
not loading, 211–212
tabbed browsing, 70

Webmail, Evolution support for, 75
who command, 402
Widgets, 285–286
Wikis

about Edubuntu, 361
description, 251–254
online resources, 251–254

Wildcards, 403
Winamp, Ubuntu/Windows equivalent, 408
Window Behavior section, 292
Window borders, 209–210
Window manager alternatives, Edubuntu,

351–352
Windows

creating Ubuntu installation CDs, 37
emulation. See Wine.
fonts, 190–191

partition access, 233, 302
partitions, sharing with Ubuntu. See Dual

boot.
sharing filesystems with Ubuntu, 45
Ubuntu compatibility, 141–142

Windows, failure to close, 201
Windows Media Format, restrictions, 112
Windows Media Player, Ubuntu/Windows

equivalent, 408
Windows partition access, 233
Windows programs, Ubuntu equivalents

3D modeling, 410
Abiword, 407
Access, 408
accounting, 409
AIM, 409
Alias Maya, 410
astronomy, 410
Banshee, 408
Base, 408
Beep Media Player, 408
Blender, 410
Calc, 407
Celestia, 410
databases, 408
desktop publishing, 409
Dia, 410
diagram editing, 410
drawing, 410
education, 410
edutainment, 410
Ekiga Softphone, 409
e-mail, 408
entertainment, 410
Epiphany, 408
Evolution, 408
Excel, 407
finance, 409
Firefox, 408
Flight Simulator, 410
FlightGear, 410
games, 410
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Windows programs, Ubuntu equivalents,
continued

GIMP, 408
GizmoProject, 409
Glom, 408
Gnucash, 409
Gnumeric, 407
Grisbi, 409
ICQ, 409
Illustrator, 410
Impress, 407
Inkscape, 410
instant messaging, 409
Internet Explorer, 408
iTunes, 408
KTouch, 410
Mavis Beacon Teaches Typing, 410
media players, 408
modeling, 410
Money, 409
Muine, 408
My Computer, 62
My Documents, 62
Network Neighborhood, 63
Office. See OpenOffice.org.
Orbiter, 410
Outlook, 408
Outlook Express, 408
personal accounting, 409
photo editors, 408
Photoshop, 408
Pidgin, 409
planetarium, 410
Planner, 410
PowerPoint, 407
presentation software, 407
Project, 410
project management, 410
Publisher, 409
Quickbooks, 409
Quicken, 409

Rhythmbox, 408
Scribus, 409
Skype, 409
spreadsheets, 407
Starry Night, 410
Stellarium, 410
system tray, 65
Thunderbird, 408
Totem Movie Player, 408
TurboCASH, 409
Tux Typing, 410
typing tutor, 410
vector drawing, 410
Visio, 410
VOIP (Voice Over IP), 409
Voyager III, 410
Web browsers, 408
Winamp, 408
Windows Media Player, 408
Word, 407
word processing, 407
Writer, 407
Yahoo instant messaging, 409

Windows won’t close, 201
Wine Windows Emulator, 141
Wired LAN can’t connect, 211
Wireless cards, 213–215
Wireless network information, displaying, 400
Wireless networks, Kubuntu, 296
Word

fonts look wrong, 190–191
Ubuntu/Windows equivalent, 304, 407

Word processing. See also Desktop publishing.
Abiword, 407
Ubuntu/Windows equivalent, 407
Word, 190–191, 304, 407
Word Processor, 304
Writer

choosing fonts, 73
file formats, 73–74
in Kubuntu, 304
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saving documents, 73
Ubuntu/Windows equivalent, 407
writing a letter, 72–74

Word Processor, 304
Working directory, printing, 397
Workspaces, 66
World atlas, 329
WPA support, 213–215
Writer

choosing fonts, 73
file formats, 73–74
in Kubuntu, 304
saving documents, 73
Ubuntu/Windows equivalent, 407
writing a letter, 72–74

Wrong kernel, 189

X configuration, online resources, 190
X server, restarting, 199

XDG Base Directory Specification, 
299–300

XDG directories, 299–300, 301
Xen, virtualization, 179–180
xmltv package, 210
xterm, alternative to Terminal, 227
Xubuntu, 30, 35, 368–369
XVM, virtualization, 180
xVM, virtualization, 180

Yahoo instant messaging, 409
Yahoo! Mail, 75

zcat command, 176. See also cat command.
zgrep command, 176. See also grep command.
Zimmerman, Matt, 321
zless command, 176. See also less command.
Zoning, virtualization, 179
z/VM, virtualization, 179
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